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ABSTRACT

The Gawler Range Volcanics (GRV) have been extensively studied previously, but a
source and emplacement mechanism has yet to be agreed upon. This study aims to
constrain the source region of the GRV and to make deductions about how the GRV
evolved. This has been done through a number of modelling techniques, including AFC
modelling and use of the Rhyolite-MELTs program. The eng Values vary widely across
the GRV, and these have been used in conjunction with trace element geochemistry to
constrain the source region. It is deduced that the most primitive GRV basalts were the
result of limited fractionation of a re-enriched refractory harzburgite source in the sub-
continental lithospheric mantle. It is then shown that the entire GRV suite can be
derived from one fractionation trend, however some assimilation is required.
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INTRODUCTION

The Gawler Range Volcanics (GRV) and the co-magmatic Hiltaba Suite (HS) granites
form a silicic-dominated large igneous province (SLIP), with a current preserved
outcrop extent of about 25,000 km? (see Figure 1; Agangi et al. 2010). The Gawler
SLIP also extends underneath younger formations in the northeast, giving a total
minimum extent of 90,000 km? (McPhie et al. 2008), resulting in a total estimated
volume for the Gawler SLIP of more than 100,000 km® (Kamenetsky et al. 2000) of
which the volcanics potentially represent 25,000 km® (Agangi et al. 2012). The Gawler
SLIP is located in the central portion of the Gawler Craton (GC) in South Australia
(Kamenetsky et al. 2000) and occurred in an intracontinental setting during the final
tectonothermal episode of the Gawler Craton development (Allen et al. 2003). The
GRV have yielded U-Pb zircon ages in the range 1591+3 to 1592+3 Ma (Fanning et al.
1988, Agangi et al. 2012), which has contributed to the event being linked to Laurentian
supercontinent assembly (Allen et al. 2008).

The GRV (see Figure 2) are composed of dominantly rhyolite and dacite lavas and
minor pyroclastics, with basaltic magmas representing a small fraction of the provinces
total volume (>90 vol. % of the succession is felsic; Agangi et al. 2012). The generally
flat-lying GRV has been subdivided based on structural, stratigraphic, and geochemical
features (Agangi 2011). The older Lower GRV (LGRV) is composed of small- to
moderate- volume lava flows with diverse compositions from basalt through to rhyolite,
and includes locally conspicuous ignimbrites (Kamenetsky et al. 2000). The LGRV
comprises a number of sub-units, with the largest volume units (100 to 200 km?) being
the Yantea Rhyodacite, Lake Gairdner Rhyolite and Wheepool Rhyolite (Agangi 2011).

Other significant units include Waganny Dacite and Bitalli Rhyolite (Allen et al. 2009).
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Fractionation trends have previously been said to indicate that the felsic LGRV units are
direct fractionates of the mafic units (Wade et al. 2012).

The more voluminous Upper GRV (UGRYV) consists of extensive, gently dipping to flat
lying, felsic lava flows and very minor ignimbrites (Agangi 2011). The UGRV is
composed of at least three large volume (>1000 km®), compositionally homogenous
felsic massive lavas (Agangi et al. 2012) that are dacitic to rhyolitic in composition
(Allen et al. 2003). The most extensive of these units (and the entire GRV) is the
Yardea Dacite, which covers an area in excess of 12,000 km? (Giles 1988). The other
main unit of the UGRYV is the Eucarro Rhyolite. The LGRYV are also known as the
‘developmental phase’ as there is a range of mafic to intermediate lavas, including at
least 400 metres of subaerial basaltic lava flows (Giles 1988). The UGRYV are thus
termed the ‘mature phase’.

There is evidence that the felsic magmas, including the Yardea Dacite, erupted at high
temperatures (900 - 1100°C), and were relatively dry and F-rich (Stewart 1994, McPhie
et al. 2008, Allen et al. 2009, Agangi et al. 2012). The GRV are metaluminous to
peraluminous, and alkali-calcic to calc-alkalic (Frost et al. 2001, Agangi 2011). Other
geochemical signatures of the GRV include relatively high K, REE and HFSE
concentrations, and the dacites and rhyolites have low Ca, Mg, Cr and Ni abundances
compared to average crustal values or to Phanerozoic calc-alkaline rocks (Agangi
2011). Many authors have affiliated the GRV with anorogenic, A-type magmas based
on these characteristics (Collins et al. 1982, Whalen et al. 1987, Giles 1988, Creaser and
White 1991, Wade et al. 2012). The lower GRV also includes basaltic lava flows,

including some very primitive compositions with high MgO and Cr and Ni (see Table
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2). These are low Ti tholeiites and compared to MORB (see Table 2) the most primitive
are poorer in Na,O, CaO, Fe;O3and TiO,.

In general, it has been largely accepted that in order to generate such large amounts of
magma (both silicic and associated mafic) as are found in SLIPs, a mantle source of
heat is required (Bryan et al. 2000, Agangi 2011). Previous petrographic studies of the
GRV have shown that the more mafic magmas were derived from the mantle, while the
silicic magmas were generated by fractional crystallisation and melting the crust (Allen
et al. 2003, Allen et al. 2009). The initial eng Values of the LGRV are highly variable,
ranging from of -7.4 to -1.6 in the Chitanilga Volcanic Province and -3.6 to +1.2 in the
Glyde Hill Volcanic Province (Stewart 1994). This indicates that there was variable
contribution of more than one magma source, which is also supported by the

compositional variations across the GRV. The UGRYV is relatively homogenous with
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limited compositional variation. It has relatively constant eng Values between -3.8 and
-4.5 (Stewart 1994). This further supports the idea that the magma must have had
multiple sources that have mixed to different degrees. The lesser degree of variation in
the UGRV may also indicate that the magma chamber was larger, and more
homogenised.

Geothermometry, geobarometry and geochemical and isotopic modelling suggest that
the Gawler SLIP originated by ponding of large volumes of mantle derived magma in
the mid to lower crust. In order for assimilation and fractional crystallisation (AFC:
DePaolo (1981)) processes to take a magma from the primitive source magma
composition to the most siliceous felsic composition, it is possible that the total initial
mass of the mafic parental magma may have been three to four times the extruded
volume of dacites and rhyolites. The results of our calculations indicate that the most
siliceous dacites and rhyolites resulted from up to 30% crustal digestion during
crystallisation. The parental mafic magma was potentially produced from
asthenospheric upwelling, either as a plume or due to decompression of the upper
asthenosphere in lithospheric ‘cracks’ (rifts). At the same time, as later discussed in this
paper, there is strong evidence that contaminated or enriched sub-continental
lithospheric mantle (SCLM) also provided a separate source of mafic melts. The nature
of the GRV parental magma will be assessed based on geochemical and isotopic
evolution, with two main theories tested and presented: 1. a Mid-Ocean Ridge Basalt
(MORB) parent contaminated by GC crust and 2. a partial melt of a depleted mantle
(DM) parent with GC crustal contamination. These two possible sources will also be
run through AFC models and comparisons made between the output and measured

isotopic values to assess whether the GRV could be derived from pure fractional
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crystallisation or combined AFC processes. Some calculations will then be made to
estimate the volume of mafic parental magma that would have been required to produce
the extruded volume of GRV.

A range of geothermometric and geobarometric methods will be used to estimate
temperatures (T) and pressures (P) of the stages of magmatic evolution. The Rhyolite-
MELTSs program developed by Gualda et al. (2012) will also be used to model liquid
evolution trends from potential parental basalts that are represented in the LGRV. The
quality of the Rhyolite-MELTs models will be assessed through direct comparison with
the GRV lavas and their trends, and by correlation of the P-T conditions in the Rhyolite-
MELTs models with the values obtained from the samples through geobarometry and

geothermometry.

METHODS

The work done by Stewart (1994) was used as the starting point for this study. The
geochemical analyses run by Stewart (1994) covered a range of rock types and locations
within the GRV, however there was less data for the LGRV and successions showing
variations in magma composition. The main goal of this study was to further develop
the work of Stewart (1994), particularly by filling in these gaps. New data was obtained
by geochemical analysis of samples taken from drill core made available by DMITRE
(now the Department of State Development). The drillhole DD88ME-2 was chosen as a
source of new sample data as it showed variation in lithology, with interlayering of
pyroxenites, andesites, and dacites (noting that the relationships between the lithologies
in this hole are quite enigmatic). Eighteen samples were collected from the core and

whole rock geochemistry was obtained using XRF and Solution ICP-MS.
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More recent work into modelling programs, such as that done by Gualda et al. (2012)
into the program Rhyolite-MELTS, was then utilized to assess the magma chamber
evolution and possible source compositions. The program Rhyolite-MELTS generates
models of magma chamber evolution over different pressure and temperature space,
based on the input of geochemical data. The program predicts the mineral assemblages
one might expect to form under the varying circumstances. Other temperature and
pressure modelling was done using a variety of geothermometric and geobarometric
programs such as those developed by Putirka (2008) (T-dependency of feldspar-melt
and olivine-melt relations; P-dependency of site substitution in clinopyroxene (Nimis
1999), zircon saturation temperatures (Watson 1979) and P-dependency of peridotite
melts (Lee et al. 2009)) to compare to the Rhyolite-MELTSs output. Additional
modelling into possible source magmas was conducted, with particular interest in
comparing mid-ocean ridge basalts (MORB) with the most primitive GRV units and

assessing the levels of contamination from Gawler Craton crust.

OBSERVATIONS AND RESULTS

Core samples

The target core was selected in a quest to access more mafic lavas from the LGRV in
order to provide more evidence for petrogenetic modelling. The drill hole selected was
indeed composed of interlayered felsic lavas and mafic (or in fact ultramafic) rocks. As
it turned out many of the mafic horizons turned out to be cumulate-textured pyroxenites.
These are relatively fresh with fresh pyroxenes and sometimes olivine. They also seem
to be undeformed, suggesting they post-date the main orogenic events experienced by

the Gawler craton. Prior MESA/ DMITRE interpretation has assigned these rocks to the

10
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Lower GRV. Of the eighteen samples taken from the core, ten were from pyroxenite
layers that had very similar geochemistry despite being interlayered between other
igneous rock types, including dacites and andesites. A brief description of the sample
depths, rock types and features can be found in Table 1. For a full core log, including
descriptions of layers not sampled, see Appendix B.

Contacts between each rock type were difficult to describe due to the limited width of
the core and the core being broken up in many places. As such, it is difficult to draw
conclusions about the nature of the succession and exactly how the rocks are
structurally related to each other.

The pyroxenites have lower TiO,, Al,O3, Na;O, and K0 than the other core samples,
and higher FeO, MgO, and CaO. They are also very high in Cr, with values similar to or

higher than a small range of primitive mafic GRV rocks previously analysed.

Table 1: Summary of drill core samples

Sample Sample | Rock type Features

depth number

from-to

(m)

73.2-73.3 | 2067545 | Porphyritic dacite/ | Phenocrysts of plagioclase, k-spar
rhyodacite Fine laths of hornblende and biotite

Fine quartz groundmass

77.05- 2067546 | Porphyritic dacite Similar to 2607545

77.15

85.5-85.6 [ 2067547 | Pyroxenite 40% plagioclase, 25-30% amphibole,

some magnetite, pyroxene
Intercumulate mica (?)

97.05- 2067548 | Vesicular/ Irregular vesicles, some filled
97.15 amygdaloidal basalt | Quartz pieces remnants of crystal
digestion (?)

Fresh pyroxenes

99.8-99.9 | 2067549 | Hornblendite K-spar phenocrysts, amphibole needles
Lamprophyric
Delicately preserved texture

106.5- 2067550 | Pyroxenite Similar to 2067547
106.6 Massive to very weakly foliated
119.05- 2067551 | Porphyritic andesite | Zoned plagioclase phenocrysts
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119.1 Amphibole phenocrysts look original
Looks like typical GRV andesites/
dacites in thin section

125-125.1 | 2067552 | Porphyritic andesite | Very similar to 2067551

135.7- 2067553 | Pyroxenite Similar to previous pyroxenites

135.8 Intercumulate clinopyroxene

145.4- 2067554 | Alkali dolerite (?) Distinct amphibole needles

145.5 Chilled upper contact with andesite
layer

156.35- 2067555 | Andesite K-spar, plagioclase and rare biotite

156.4 laths in quartzose groundmass
Indistinct lower contact (with sample
2067556)

166.15- 2067556 | Pyroxenite Equigranular plagioclase, olivine (?)

166.25 Laths of biotite

201.5- 2067557 | Pyroxenite Rare xenoliths of quartz-k-spar

201.6 porphyry and k-spar-quartz-biotite
gneiss

218.8- 2067558 | Pyroxenite

218.9

223.8- 2067559 | Pyroxenite

223.9

247.5- 2067560 | Pyroxenite

247.6

267.1- 2067561 | Pyroxenite

267.2

297.8- 2067562 | Pyroxenite Cumulative texture

297.9

Geochemistry

Overall, the developmental phase GRV show a much greater compositional diversity

than the mature phase GRV. The high-silica samples from the drill core tend to plot on

the same trend as the main body of existing GRV data (see Figures 2 and 3), close to the

Yardea Dacite values. Other core samples, particularly the pyroxenites, appear to

continue the trends into lower silica values. MORB values have been included in all

geochemical plots for comparison.
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The pre-existing GRV data as well as the new analyses reported here are displayed on a
TAS diagram (see Figure 2). This shows a positive correlation between total alkalis and
silica and also shows that the GRV extends from basalts through andesites to dacites
and rhyolites. In the Harker diagrams (see Figure 3), the GRV data define coherent
trends consistent with crystal-liquid fractionation. Close inspection of these broad trends
also tend to reveal discrete sub-trends. CaO, FeO, and MgO all decrease with increasing
SiO,, while K,O shows continuous enrichment. Al,O3, Na,O, P,Os and TiO, each show
inflected trends with initial enrichment followed by a change to depletion at around
60% SiO,. While there is a large gap between their compositions and those of the GRV,
the pyroxenites consistently fall on the extrapolation of the mafic GRV basalt towards
more primitive end-members. As discussed later, their orthopyroxene (OPX)-
clinopyroxene (CPX) * olivine mineralogies are those predicted by Rhyolite-MELTs
simulations to explain the early stages of GRV fractionation of primitive basaltic parent
magma. This is also consistent with their cumulate textures. The intermediate core
samples fall on the GRV trends, clustering around the low silica end of the mature

phase (like some Yardea dacites).
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Figure 2: Total alkali vs. SiO, (TAS) plot for the GRV (data from Stewart (1994)),

samples from drillhole DD88ME-2, and MORB (data from Melson et al. (2002)) for
comparison. IUGS classification (from Le Bas et al. (1986)) is shown in black dotted 13
lines with the fields labelled in italics.
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Figure 3: Harker diagrams — variation of major elements vs. SiO, for the GRV (data from Stewart (1994)), samples from
drillhole DD88ME-2, and MORB (data from Melson et al. (2002)) for comparison. 14
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Figure 4: Primitive mantle normalised spidergram showing averages for three types of rock found in the core,
and a selection of Upper and Lower GRV units (GRV data from Stewart (1994)). Normalising values are from
Sun and McDonough (1989).

The available trace element data for the existing GRV dataset was not as extensive as
what we analysed for in the core samples, however comparisons can still be made based
on what is available, and overall trends. The primitive mantle normalised (PMN)
spidergram (normalising values from Sun and McDonough (1989)) can be found in
Figure 4. A selection of rock types from the GRV are plotted with averages of the three
most abundant rock types found in the core — pyroxenite, dacite, and andesite. Large ion
lithophile elements (LILE) are on the left of the figure, and high field strength elements
(HFSE) on the right. These all show a negatively sloping trend. For most of the
available elements, the GRV and core dacites and andesites appear to be relatively
similar, except for a difference in Y. As with most of the GRV rocks, the core samples

show distinct Nb and Sr depletions, and strong Pb enrichments.
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Figure 5: gyq (1592) vs. MgO for the available GRV data (Stewart 1994), with
average MORB plotted for comparison (Melson et al. 2002).

ISOTOPES

Figure 5 shows the available eNy data at 1592 Ma versus MgO wt.%. This data was not
collected for the core rocks, so only the previously analysed GRV data is presented,
with comparison to average MORB. There is a significant degree of variation between
the eng values (+1.2 to -7.4) for the GRV. It is noted that MORB &ng at 1592 Ma was +6
and GC crustal values down to about -15 (Stewart 1994). There is a general trend

towards lower eng With decreasing MgO, as the magmas become more felsic.

16



Jade-Starr Tregeagle
Petrogenesis of the Gawler Range Volcanics

REE PATTERNS

Rare earth element (REE) patterns for the drill core samples and three mature phase
GRV rocks are presented in Figure 6. The core samples seem to have somewhat
different REE patterns than those from the GRV (noting that there is very limited REE
data on the GRV rocks). The drill core rocks are significantly more depleted in the
middle to heavy REE (M-HREE). The drill core samples therefore have significantly
higher La/Yb and Sm/Yb ratios that the GRV. On the other hand, the La/Sm values for
both suites are similar. Whereas the mature phase GRV have a negative Eu anomaly,
this is also not evident in the core samples. The more felsic core rocks are more similar
to the GRV, except in the HREE that are noticeably more depleted than the core rocks.
The Eucarro and Nonning Dacites have almost identical REE and PMN trace element
patterns. Interestingly, although the pyroxenites are texturally cumulate rocks
dominated by clinopyroxene and orthopyroxene, they are nevertheless LREE-enriched
and have the same MREE-HREE depletion seen in the felsic lavas from the drill core. It

has to be said that the samples from the drill core remain an intriguing issue. Are they
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Figure 6: REE plot for core sample averages and the three previous mature phase GRV analyses (Stewart
1994). These are primitive mantle normalised (normalising values from Sun and McDonough (1989)).
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really part of the lower GRV as prior interpretation would have it, or are they unrelated?

Table 2: compositional comparisons between primitive GRV basalts and MORB, with the

calculated primary melt compositions for the GRV basalts (based on supplementary program from
Lee et al. (2009)).

Most Calculated Calculated Calculated
Average Primitive | primitive | GRV | GRV primary primary primary
MORB GRV GRV Basalt | basalt mel'g _ meIF _ meIF _
Basalt K8 Basalt K110 K33 composition | composition | composition
K101 K101 K110 K33
SiO; 50.45 51.00 51.91 51.94 | 52.01 51.82 50.43 50.07
TiO, 1.44 0.62 0.64 0.85 0.82 0.63 0.72 0.68
Al,Os 15.31 14.14 13.65 15.87 | 16.02 13.36 13.37 13.34
FeOm | 10.26 8.66 8.69 9.16 9.71 8.73 9.53 9.89
MgO 7.65 10.96 11.77 7.72 8.44 12.75 14.45 15.00
CaO 11.67 7.54 8.55 8.88 8.62 8.37 7.48 7.19
Na,O 2.52 3.15 2.15 2.56 251 211 2.18 2.09
K,O 0.13 0.28 1.27 1.23 1.06 1.24 1.04 0.88
P,Os 0.14 0.18 0.18 0.24 0.25
La 3.96 27.0 n.d. n.d. n.d.
Ce 11.12 66.0 78.0 54.0 58.0
Ba 22.59 492.0 1005.0 842.0 | 718.0
Rb 211 9.7 45.0 42.0 36.0
Cr 269.41 941.0 1050.0 619.0 | 600.0
Ni 108.13 289.0 362.0 197.0 | 192.0
Sc 42.03 31.0 29.0 32.0 30.0
£Nd +6 -1.88 n.d. n.d. n.d.

Table 3: the un-normalised trace element compositions of average GRV basalt, MORB, depleted
mantle and GC crust used in modelling, with contamination values for MORB +25% GC crust and
DM + 5% GC crust. These values were used to indicate how well the modelled contamination could
suit the observed GRYV data.

Av GRV Basalt | GC crust MORB MORB + 25% GC | Depleted Mantle | DM +5% GC
Rb 32.38 118.77 | 2.108910122 31.275 0.0800 6.01
Ba 492 650.52 | 22.59766514 179.579 0.9080 33.39
Th 4.35 28.12 0.264192041 7.228 0.0160 1.42
U 1 3.00 0.088480735 0.816 0.0072 0.16
Nb 5.92 9.72 4.063180441 5.477 0.3456 0.81
K 7803.397028 | 28673.98 | 1087.901774 7984.421 200.0000 1623.70
La 32 59.13 3.960869986 17.752 0.5360 3.47
Ce 64.4 105.25 | 11.11547216 34.649 1.6840 6.86
Pb 12.2 22.61 0.46385136 6.000 0.1360 1.26
Sr 539.86 172.26 | 114.8313747 129.189 24.3680 31.76
P 1125.96689 367.78 | 620.7108134 557.479 160.0000 170.39
Nd 34 37.35 9.508429064 16.468 1.9320 3.70
Zr 121.58 229.45 | 83.08697881 119.677 17.0760 27.69
Sm 5 8.01 3.249083409 4.440 0.8400 1.20
Eu 1.2 1.15 1.190238113 1.179 0.3440 0.38
Ti 4927.884856 2960.19 | 8651.013813 7228.309 3560.0000 3530.01
Dy 3 3.22 5.10481303 4.634 1.8840 1.95
Y 22.62 22.13 28.70840833 27.063 12.5160 13.00
Yb 1.2 1.50 3.176753358 2.757 1.3920 1.40
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DISCUSSION

The project utilised the geochemical and isotopic data from Stewart (1994). Her data
showed that the GRV extended from basalts, through andesites to dacites and rhyolites
and, though often referred to as “bi-modal”, it in fact has representation over the entire
silica range. However, of course, the volumetric representation is hugely skewed
towards the dacites and rhyodacites. Stewart (1994) identified two basaltic sub-groups;
1. low phosphorous and titanium (LPT) basalts and 2. the high phosphorous and
titanium (HPT) basalts and basaltic andesites. These lavas are the most primitive of the
GRV and plot at the lowermost SiO, range of the Harker diagrams in Figure 3. These
GRV basalts are comparatively enriched in most lithophile trace elements presented in
the PMN spidergram plot although most have lower Ti (see Figure 4) and other HFSE.
The most primitive LPT basalts have very high compatible trace element (Ni, Cr, Sc)
concentrations, but also have high LILE/HFSE ratios, LREE enrichment. At the same
time, these basalts (from outcrops in the Kokatha area) range up to samples with very
high MgO (> 11%), the highest values of the GRV. Their MgO, Cr and Ni values are
high compared to MORB (values for which are from Jenner and O'Neill (2012) and
Melson et al. (2002)), but the values for CaO, Na,O, TiO,, FeOr) are lower. This
indicates a refractory mantle source with little or no CPX. Clearly the most MgO-rich of
these samples (e.g. K101) have undergone almost no fractionation to produce the
earliest GRV. This compositional comparison is summarised in Table 3. Compared to
MORB, the GRV basalts also have higher K,O , LREE, Pb, Rb, Ba, U and Th.
Tellingly, although MORB at 1592 Ma had an gng Value of about +5.9, the GRV basalts

fall in the range -1 to -3.
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In order to be able to make assessments about the potential source of the GRV, Stewart
(1994) identified the geochemical and isotopic characteristics of some potential crustal
source lithologies. Stewart (1994) concluded that the trace element geochemistry of the
GRYV basalts could not be achieved from asthenospheric basalts (e.g. MORB) alone. In
particular, she inferred that the LREE enrichment and high LILE/HFSE ratios must
have been derived from the continental lithosphere (Stewart 1994). These conclusions

are further explored here.

Source

It is clear that the GRV suite includes small volumes of very primitive basalt. The
preceding discussion drew attention to characteristics which on the one hand suggested
a very refractory (harzburgite) mantle source, but at the same time showed lithophile
crust-like features. The obvious question is whether the basaltic potential parents to the
GRV are MORB-type mantle melts that have been contaminated by continental crust as
they ascend, or melts of a refractory harzburgite mantle that has been contaminated by
crustal material (either due to prior subduction processes or due to basal crustal
delamination)? Both these models are tested below. Both these options have been
modelled using the equations of DePaolo (1981) by mixing the parent composition with
progressively greater amounts of Gawler Craton Archean crust. The isotopic
compositions of each component at 1590 Ma were considered as an indication of how
similar to the GRV data the potential parent would become. These models are based on
pure fractional crystallisation of the parent magmas and are used to give an indication of
what the source composition may have been prior to partial melting. A further test was
then applied to assess if partial melting of that source could produce the trace element

patterns of a primitive GRV basalt (using the equations of Shaw (1970) and Greenland
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Figure 7: the calculated pressure and temperature conditions of melt
segregation from the mantle for three of the most primitive GRV
MANTLE MELTING basalts. Based on the calculations of Lee et al. (2009).

CONDITIONS

The routine of Lee et al. (2009) was used to assess the primary magma composition of
the GRV. Based on silica activities, this calculates the pressure (and temperature) at
which basaltic melts can be derived by partial melting of a peridotite source. The results
of these calculations are summarised in Table 2 and Figure 7. The diagram in Figure 7
also shows a range of adiabats for different mantle potential temperatures (the steep
grey lines). Normal MORB asthenosphere would be close to the coolest of these
adiabats, reaching surface pressures at about 1300°C. These calculations imply that the
most primitive GRV LPT basalt is very near to a primary melt (i.e. has experienced very
little fractionation) and must have been derived by very shallow melting (approximately
1.6 GPa, which is equivalent to about 50 km depth) and around 1360°C. This is a depth
in the mid to upper levels of the SCLM where temperatures are more likely to be around
850°C. If indeed (as discussed below), the parental GRV basalts are derived from

contaminated harzburgitic SCLM and not the result of simple crustal contamination of
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MORB-like melts, then these pressure-temperature results pose some interesting
geodynamic/ tectonic questions as to how such high temperature melting occurred well

inside the SCLM.

Option One — MORB-like parent with contamination from Gawler Craton Archean
crust?

For this model, a mantle derived basalt with MORB composition and crustal
contamination from GC Archean crust was simulated. The primary outcome of this
modelling is shown in Figure 8. This model was able to produce an ¢Nd value
comparative to the primitive GRV basalts only after 15-20% addition of GC Archean
crust. The PMN trace element trends (see Figure 9) also do not match up with those of
the GRV basalts. While some elements are similar, key differences occur in other
elements. Some of the modelled values are too high for the GRV basalts, such as Th, Ti

and Yb; while others are too low, such as Ba, Pb and Nd. Ultimately, regardless of how
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Figure 8: Option One — gy vs. concentration Nd modelling from MORB source composition
compared with actual GRV data. Percentages are the amount of Gawler Craton crustal contaminant
added to the MORB source composition.
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well the trace element data fits, this model would result in a bulk composition that is
much more siliceous than the primitive GRV basalts. It therefore cannot be considered a

feasible model for the GRV source.
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Figure 9: PMN trace element patterns for MORB, a primitive GRV basalt and the modelled MORB + 25% Gawler
Craton crustal contamination.

Option Two — Depleted Mantle source with contamination from Gawler Craton
Archean Crust?

This model involved the mixing of a depleted mantle peridotite source and the GC
Archean crust at 1590 Ma. The primary output of this model can be found in Figure 10.
Under this model, obtaining a composition that is isotopically like the most primitive
GRV requires around 5% addition of crustal material. However, this resultant
composition has a much lower concentration of Nd than the GRV (3.68 ppm versus 32
ppm for the GRV). This disparity is related to the affinities of Nd and can be accounted
for by melting the contaminated source by about 15%. Most importantly, the eNd values
are similar without the modelled melt becoming more siliceous than the most primitive

GRV.
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Figure 10: Option Two — gyq Vs. concentration Nd modelling from a depleted mantle source
compared with observed GRYV data. Percentages are the amount of Gawler Craton crustal
contaminant added to DM source composition. The pink arrow indicates the difference in
concentration that would be achieved with approximately 15% partial melting of the
contaminated DM source (that includes 13% garnet).

The partial melting modelling also shows that there must have been around 13% garnet
in the depleted mantle source in order for the trace element signatures to be replicated.
This was based on the distribution coefficients of a number of trace elements in typical
peridotite minerals (values from Rollinson (1993)). The partial melting model is
summarised in Table 4. As this table shows, the percentages of the minerals olivine
(Ol), orthopyroxene (OPX), clinopyroxene (CPX) and garnet (Gar) were able to be
altered, as was the fraction of melting. The values presented here are the final amounts
that were required to achieve the PMN trace element pattern that best fit the GRV data
(see Figure 11).

The PMN spidergram (see Figure 11) shows that the trace element signatures for the

GRV can be replicated reasonably well in this model. While the pure depleted mantle
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pattern is quite far off, it at least begins with lower concentrations in the HFSE than the
GRV, which then allows the crustal contaminant to alter these concentrations only so
much that they match the GRV. This is opposed to the MORB-like source in which the
HFSE concentrations start higher than the GRV values, and cannot be brought down by
the addition of crustal contaminant. The addition of only 5% crust to the depleted
mantle source reasonably accurately replicates the pattern observed in the GRV. The Pb
peak is evident, as is the Nb depletion. The result of about 15% partial melting of this
depleted mantle source is that the LILE concentrations are increased in the melt, with
little effect on the HFSE element concentrations. This results in the final PMN pattern

very closely matching the observed GRV pattern.

Table 4: summary of partial melting modelling for the depleted mantle + 5% GC crustal
contamination

Kd Values Ol:.OPX:CPX:Gar | Fract. Melting
Partial Melting Model | Ol Opx Cpx Gar 39:40:8:13 0.15
Rb 0.0100 | 0.0220 | 0.0310 | 0.0420 0.02064 | 35.89861486
Ba 0.0100 | 0.0130 | 0.0260 | 0.0230 0.01417 | 206.0465558
Th 0.0100 | 0.0200 | 0.0300 | 0.0100 0.0156 | 8.704792628
U 0.0100 | 0.0050 | 0.0150 | 0.0050 0.00775 | 1.001612517
Nb 0.0100 | 0.0130 | 0.0260 | 0.0230 0.01417 | 5.024943423
K 0.0100 | 0.0130 | 0.0260 | 0.0230 0.01417 10020.0806
La 0.0070 | 0.0200 | 0.0560 | 0.0010 0.01534 | 21.25585494
Ce 0.0060 | 0.0220 | 0.0920 | 0.0070 0.01941 | 41.21571999
Pb 0.0140 | 0.0130 | 0.0260 | 0.0230 0.01573 | 7.710354345
Sr 0.0140 | 0.0130 | 0.0260 | 0.0230 0.01573 | 194.4214519
P 0.0140 | 0.0130 | 0.0260 | 0.0230 0.01573 | 1042.961902
Nd 0.0060 | 0.0280 | 0.1800 | 0.0260 0.03132 | 20.96460552
Zr 0.0070 | 0.0500 | 0.2500 | 0.1020 0.05599 | 140.1608313
Sm 0.0070 | 0.0500 | 0.3400 | 0.1020 0.06319 | 5.883820719
Eu 0.0070 | 0.0500 | 0.4740 | 0.2430 0.09224 | 1.681559868
Ti 0.0130 | 0.2000 | 0.5820 | 1.9400 0.38383 | 7412.008332
Dy 0.0130 | 0.2000 | 0.5820 | 1.9400 0.38383 | 4.096120675
Y 0.0300 | 0.2000 | 0.6000 | 3.0000 0.5297 | 21.65214019
Yb 0.0490 | 0.3400 | 0.5420 | 5.0000 0.84847 | 1.603794538

25



Jade-Starr Tregeagle
Petrogenesis of the Gawler Range Volcanics

1000.0000

100.0000

10.0000

1.0000

0.1000
00100 T T T T T T T T T T T T T T T T T T T 1
Rb Ba Th U Nb K La C¢e Pb Sr P Nd Zr Sm Eu Ti Dy Y Yb
Depleted Mantle #r=Depleted Mantle + 5% Crustal Contamination

el==melt due to 15% melting of Contaminated Mantle e=f==Average GRV Basalt

Figure 11: PMN trace element patterns for depleted mantle, primitive GRV basalt and the modelled results of
DM + 5% GC crustal contamination and 15% melting of that magma.

Of these two options for the GRV source magma, the contaminated depleted mantle
model seems to be the most likely. This model requires much less total contamination
and crystallisation to reach the observed data points. It has also been noted by a number
of authors (Francis 2003, Griffin et al. 2003, Arndt et al. 2009) that the sub-continental
lithospheric mantle (SCLM) beneath Archean cratons is typically depleted. This further
supports the idea that the GRV source may have been a contaminated depleted mantle

as it is highly likely that a form of depleted mantle exists beneath the Gawler Craton.

Rhyolite-MELTs modelling

The most primitive LPT basalt was used as the starting bulk composition of the magma
chamber for the purpose of the Rhyolite-MELTs modelling. It was found that a single
fractional crystallisation trend is able to produce the geochemistry of the GRV from

developmental to mature phase. This is shown in the second set of Harker diagrams in
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s
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to be reached a two- .
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stage model needed to  Figure 12: The fractional crystallisation trend of the GRV as modelled
by Rhyolite-MELTSs. The blue arrows show the range of SiO, that is
observed in the most voluminous felsic GRV units, the Eucarro and
Yardea Dacites, and indicate how much of the remaining melt they
would represent under this model (approx. 14-20%).

be devised. In the first
stage, the most
primitive LPT basalt was crystallised under three kbar of pressure. This resulted in a
dacitic composition of approximately 63% SiO,. In order to achieve the nearly 75%
SiO; of the mature phase GRV, a second stage model was run, with the most mafic
GRV dacite used as a middle composition and a pressure of one kbar. This is what
produces the ‘step’ in the modelled trends.

Geochemically, the Rhyolite-MELTs model fits very well with the observed GRV data.
The major element oxide trends are predominantly reproduced quite accurately (see
Figure 14). The P,Os trend is not shown here as Rhyolite-MELTs was not able to model
the crystallisation of apatite correctly, so this was the one trend that did not fit the data.
The FeO() content is a little low across the trend, while CaO and TiO, could be
considered to be a bit high. While the Al,O3 trend is slightly too high at the beginning
of the model, it aligns with the GRV data after about 58% SiO,. The modelled NaO,

K0, and MgO trends all align through the middle of the GRV data. Interestingly, the
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Figure 13: wt. % SiO, vs. temperature of the GRV as modelled by

Rhyolite-MELTS. Inset is a subset of the same graph with temperatures

for the Eucarro and Yardea Dacites calculated by methods described by

(Putirka 2008).
core pyroxenites are all either clustered around the beginning of the Rhyolite-MELTs
model trend or lie in direct line with it. This will be discussed later.
This modelling indicates that the most voluminous GRV, the Eucarro and Yardea
Dacites, at around 65-72% SiO,, would be the product of approximately 80%
crystallisation (see Figure 12). The mature phase GRV would thus require about four
times their mass as gabbroic and pyroxenitic crustal intrusives, the evidence for which
is severely lacking. This also requires the volume of the primary melt to be significantly
large, as these two units make up the greatest portion of the GRV but by this model
reflect only a small volume of the total magma.
Using the thermometer and barometer calculation equations from Putirka (2008),
mineral-specific data from microprobe analyses was used to make pressure and
temperature estimates for a limited number of GRV rocks. Most of the calculations

were based on minerals found in the Eucarro and Yardea Dacites. A subset of these

calculations can be found in the inset of Figure 13, in comparison with the Rhyolite-
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MELTs model. The returns from these calculations were consistent with those from the
Rhyolite-MELTs modelling. The Rhyolite-MELTs model indicates crystallisation began
at 1347°C. The Yardea and Eucarro Dacites began crystallising at about 1000°C and
continued to crystallise through to about 840°C. This is also indicated on Figure 13. The
temperature returns from both the modelling and the calculations are largely consistent
with the temperature range previously calculated by Agangi et al. (2012) for the mature

phase GRV at around 900-1100°C.
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Temperatures from zircon saturation calculations are also consistent with these
calculations, with a range of 840-940°C (see Figure 15b) for the inflection point of the
GRYV samples. The inflection occurs at about 70% SiO, wt.%. This inflection point is
where zircon becomes saturated in the magma with falling temperatures and increasing
SiO,. This is also the point where differentiation increases. At SiO, <70%, the magma is
zircon under-saturated and magma T is greater than zircon saturation T. On the other
side of this inflection point, zircon saturation temperature is greater than magma
temperature, and zircon becomes saturated. In Figure 15c¢, a comparison is made
between the zircon saturation temperatures and the calculated temperatures from the
thermometers of Putirka (2008). It can be seen that most of the calculations fall around
this inflection point.

The zircon saturation inflection point is also very similar to the inflection point in Nd
versus SiO, (Figure 16). The Nd inflection point shows the change from Nd enrichment
during fractionation to depletion. Again, this inflection occurs at around 70 wt.% SiO,.
These inflection points likely indicate an on-set of saturation of several accessory
phases that take in Zr and well as REE, such as zircon, apatite, and allanite.

While the Rhyolite-MELTs model fits the major elements data for the GRV quite well,
there is a significant amount of variation in the gng Values across the GRV that cannot
be accounted for by pure fractional crystallisation. It is therefore concluded that there

must have been some amount of assimilation of crust into the parental magma.
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Figure 16: annotated Nd (ppm) vs. SiO, wt. % graph with the inflection point labelled by the
pink lines. To the left of the inflection point, accessory phase minerals are under-saturated. To
the right, accessory phase minerals are saturated.

Combined AFC processes

While the Rhyolite-MELTSs program shows that the variation from the most primitive
GRV basalt to the most felsic GRV rhyolite can be modelled based on pure fractional
crystallisation, there is significant variation in the eng trends that indicates some level of
crustal contamination must have occurred. The inflection point of the observed GRV Nd
data informed the development of a two-stage AFC model. Two such models were
made using different possible parent magma compositions. The first was based on a
MORB-like parent and the second based on a contaminated mantle composition
calculated from the most primitive GRV basalt. In both cases, the crustal contaminant is
Gawler Craton Archean crust. The values for the crust were calculated as an average
from data presented by Stewart (1994). The final models presented here are the end
result of an essentially trial and error process, where certain values were varied. The key

value was known as the r-value. This value quantified the rate of assimilation/ rate of
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crystallisation, where an r-value of zero would represent pure fractional crystallisation.
As an example, an r-value of 0.3 would mean that when the magma reaches 100%
crystallisation, 30% of its final volume would have been from assimilation. This would
then mean that a lower starting magma volume would be required to produce the final
magma than for pure fractional crystallisation. In the case of the GRV, this would help
to explain why the felsic material can be so voluminous in comparison to the mafic

material.

Option One — can the GRV result from fractionation of a MORB parent source with GC
Archean crust contamination?

Based on a two-stage model of coupled AFC processes, the Nd trend shown in Figure
17 was produced. This model started with a MORB-like parent composition. In the first
stage, GC Archean crust was added with an r-value of 0.3. This produced the first half

of the trend until the
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Figure 17: Option One — a two-Stage AFC model with MORB parent.
Percentages indicate the amount of crystallisation. The first stage was
modelled with r=0.3 and the second stage with r=0.25. the model meets the
observed data at 50% crystallisation.
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Figure 18: Option Two — a two-stage AFC modelling with Contaminated Mantle
source. Percentages are amounts of crystallisation. The first stage was modelled
based on r=0.38 and the second stage with r =0.25. The model lines up with the
observed GRV data at about 5% crystallisation.

however, this magma required approximately 50% crystallisation before the model

agreed with the GRV data. In addition, 80% of the total volume of magma would have

to crystallise before the inflection point was reached.

Option Two — can the GRV result from fractionation of a Contaminated Mantle parent

source with GC Archean crust contamination?

Again using a two-stage model of coupled AFC processes, the Nd trend in Figure 18

was produced. This time, however, the starting parent composition was a contaminated

mantle composition based on the most primitive GRV basalts. This primary magma was

back-fractionated from the most primitive GRV basalt using the methods of Lee et al.

(2009). It is of interest that these methods did not change the composition of the GRV
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basalt very much in order to reach the most primitive parent composition. Compared to
average MORB composition, this melt composition is high in SiO,, very high in MgO,
Crand Ni, and low in CaO, Na,0, total FeO and TiO,. This composition indicates that
the source of the GRV melt was most likely a depleted refractory mantle as far as the
major elements are concerned. The high SiO, and very high Cr,O3 indicate an
orthopyroxene peridotite source, while the low CaO and Na,O suggest the source was
deficient in clinopyroxene. This is a harzburgite source, which has been demonstrated to
dominate the sub-continental lithospheric mantle beneath Archean cratons such as the
Gawler Craton (Griffin et al. 2003).

The crustal component used as the assimilant was the same as the previous model. In
the first stage, GC Archean crust was added with an r-value of 0.38. In the second stage,
after the inflection point in the Nd data, the r-value was 0.25. This model produces a
good match for the GRV data. About 5% crystallisation is required to reach the GRV
data trend. Like the MORB model, this model also requires a large amount of
crystallisation to reach the inflection point — approximately 60%.

While both models were able to mimic the trends of the GRV reasonably well, the
MORB-like parent model required a very large amount of crystallisation to reach the
GRV data. This would therefore suggest that the volume of the initial magma chamber
would have been at least twice the volume of the extruded GRV. This seems unlikely.
On the other hand, the contaminated mantle source requires less crystallisation before
the modelled trends match up with the actual data. This reduces the size of the initial
magma chamber in comparison to the MORB-like parent, however the model still
requires a great deal of crystallisation to reach the inflection point. In either case, the

magma chamber must be very large to account for the eng trend by this method.
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Figure 19: annotated &yq (1592) vs. MgO wt.% showing multiple trends in AFC
evolution of the GRV, with average MORB (data from Melson et al. (2002))

representing one possible end-member starting composition.

Multiple trends (?)

Although only one AFC trend has been calculated for the entire GRV in these models, it

is likely that multiple AFC trends could be calculated. As can be seen in Figure 19, the

eng Values appear to define several similar trends. The black arrow proposes two

possible end-member starting compositions: an average MORB composition and the

most primitive GRV basalt. In this case, the arrow extends beyond the most primitive

GRV basalt as it is likely that the end-member is somewhere beyond this sample. Three

trends have been defined, with an asthenosphere (e.g. MORB) trend in the uppermost
eng range. This trend may be more heavily influenced by asthenospheric melt than the

lower eng range trends, which may be more closely linked to a contaminated mantle

source.
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Core samples

The origin of the core rocks is still not one hundred percent certain and more data needs
to be obtained to make a better assessment. Geographically, the drillhole is positioned
relatively close to where known outcrop of the GRV exists (see Figure 1) and is
certainly in the region where the GRV are predicted to extend beneath younger
sediments (McPhie et al.). While based on the major element chemistry they seem to fit
the GRV data reasonably well, some of the minerals in thin section appear to be too
fresh to be of GRV age. In addition, the succession of rocks in the core is complicated
and the relationships are not well understood due to the limited window into the
subsurface that drillholes provide. In particular, questions remain about how the
pyroxenites came to be interlayered with the extrusives and more felsic compositions.
One contact between an andesite and a pyroxenite appears to be gradual, suggesting the
pyroxenite may have been brought up from the magma chamber by the andesite as a
crystal slurry when it extruded. The more intermediate to felsic compositions from the
core rocks plot similarly to the GRV in the Harker diagrams (see Figure 3). In
particular, the dacites seem to have major element compositions close to the Yardea
Dacite. The biggest difference is in the K,O plot, although this could be a result of K
being mobilised by alteration processes. The core shows evidence of various forms of
alteration throughout.

Largely, the core rocks have very similar major element trends. However, the PMN
trace element signatures vary significantly from the GRV patterns, particularly in the
HFSE. There is a certain amount of variation within the known GRV though, so this
does not entirely exclude these rocks as being classified as part of the GRV.

Additionally, the pyroxenites plot around the beginning of the trends, where it would be
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expected that cumulative residues from the GRV would be located, geochemically. The
compositions of the pyroxenites are very similar to those calculated in the early stages
of the Rhyolite-MELTs model. As such, conclusions can only be tentatively drawn when
relating the core rocks to the GRV.

Of particular interest for further study would be the eng Values. Knowing these would
help compare the core rocks with the GRV both in terms of age and in compositional
heritage. In addition, microprobe analysis of the thin sections would help to determine
the nature of some of the more unusual minerals, such as the apparently and

unexpectedly fresh olivines.

The volume problem

The mature phase GRV have an approximate minimum volume of 4,000 km* (Stewart
1994). The Yardea Dacite is at least 3000 km?® (Creaser and White 1991) and the
Eucarro Dacite is at least 675 km® (Allen and McPhie 2002). These volumes appear to
be based on the mapped extent of the units at the surface and the known thickness
extent. Estimates quoted earlier included shows in drillholes, but these are relatively
sparsely located and so do not define the outer limits with as much certainty as the
outcrop extent.

Based on the Rhyolite-MELTs modelling, the magma source would have had to reach
about 80% crystallisation before the composition of the mature phase GRV would have
been reached. This means that the volume of the magma must have been at least four
times the volume of the mature phase volcanics. As a minimum, this means that there
should be about 16,000 km?® of material that is more mafic to intermediate in
composition. This estimate is based on pure fractional crystallisation, however it has

been shown that a coupled AFC process was most likely acting on the GRV magma
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chamber in order for the observed eng Variation to be achieved. This would reduce the
volume of the initial magma required to produce the mature phase GRV as some of the
volume would be from addition of contaminant to the primary melt. The rate of
assimilation over the rate of crystallisation (r-value) used to produce the AFC model
from a contaminated mantle source with GC crustal contamination determines the final
volume of the required magma source. The model shows that only low r-values are
required to achieve the eyng Variation observed in the GRV. This means that the
calculated 16,000 km® would be an overestimate for the AFC model, but not by very
much. In addition, the GRV are old and significantly weathered, so the calculated

volume of the mature phase GRV is almost certainly lower than the original volume.

CONCLUSIONS

Based on the work of Lee et al. (2009) the potential primary melt of the Gawler Range
Volcanics has been calculated. This composition required very little back-fractionation
from the most primitive GRV basalt to be obtained. The composition indicates a
refractory harzburgite source. The calculated pressure that accompanies the
compositional back-fractionation calculations indicates a shallow origin for the LPT
basalts. This pressure indicates a depth of around 50 km, which is well inside the
SCLM. However, the temperature calculations indicate that this region was significantly
heated from the usual expected 850°C to greater than 1360°C. Two possible
mechanisms of introducing this heat are a mantle plume or delamination of the
lithospheric mantle (Pysklywec et al. 2010).

While the most primitive basalts in the GRV have this refractory mantle harzburgite
source composition for the major elements, the trace elements and gyg Values are more

crust-like. This indicates that the GRV melt had crustal geochemical features before any
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fractionation began. This suggests that the refractory mantle source was already re-
enriched by a contaminant of crustal origin. As discussed by Stewart (1994), sometime
before the Gawler Range volcanism the SCLM below the Gawler Craton was modified
to become enriched in REE and LILE but not HFSE. This enrichment may be related to
an Archean event (Stewart 1994).

The AFC modelling based on the variation in gng Values for the GRV indicates that this
refractory mantle source was contaminated by crustal material. The model suggests that
around 5% crustal contamination from the Gawler Craton into a depleted mantle source
would be required in order to produce the eng Values observed for the GRV. The PMN
trace element diagram also indicates that about 15% partial melting of this source is
required to achieve the observed trace element patterns. It also indicates that about 13%
garnet was present in the source composition. Based on the inflection point in the eng
trend, a two-stage AFC model of magma chamber evolution is required and has been
calculated. However, the eng Values also indicate that multiple fractionation trends are
more likely responsible for the GRV than one single trend.

The Rhyolite-MELTs modelling indicates that the entire GRV suite can be achieved in
one fractionation trend. However, the most voluminous mature phase GRV
compositions are not reached until about 80% crystallisation of the magma in this
model. This would indicate that the mafic and intermediate GRV compositions should
account for five times the volume of the felsic GRV. With an estimated volume of 4,000
km? for the mature phase GRV, this requires at least 16,000 km® volume for the parental
basalt, most of which must remain in the lower to mid crust. This is a maximum

estimate, however, as the AFC process that have been demonstrated to have been acting
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on the GRV melt mean that a certain amount of crustal material was assimilated into
this parent basalt, which lowers the required initial volume.

That the developmental phase and mature phase GRV can be linked by a single
fractionation trend according to the Rhyolite-MELTs model adds weight to the
interpretation that the GRV are likely the results of varying amounts of mixing between
to end-member sources. Given the multiple trends observed in the gng data, it is possible
that one end-member is the modelled re-enriched harzburgite source and the other is
more similar to an asthenospheric mantle source such as MORB.

Further work could be done to expand the number of samples taken from the GRV,
possibly by adding data from more recent studies to generate one more comprehensive
database. This could help to reinforce the trends and to add more certainty to their
interpretation. Given the range in eng Values, the collection/ calculation of more Nd data
would be beneficial to better constrain these interpreted trends. This would further allow
for assessment of the AFC processes that produced the GRV as separate trends based on
the eng trends. Additional analysis of the core rock samples would also help to either
classify or declassify these rocks as GRV with more definitive certainty. This would
then allow for more interpretation of the relationship between these rocks with the wider

GRV, if they were proven to be related.
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Method: Plag-Melt E/?slir_ Olivine-liq | Olivine-lig | Hbl-Plag Mean T CPXBar
Sisson & Blundy Nimis and
Author: Putirka Putirka Putirka Grove and Taylor
(1992) Holland
Egn (24a) | Egn(24b) | Eqgn.(2) Egn. 2
E:ril;le Measurement: | T(C) T(C) T(C) T(C) T(C) P(kbar) | atT
Eu7 903 894 14 820
Eu7 893 894
Eu7 910 894
Eu7 877 894
Eu7 893 894
Eu7 887 894
Eu21 860 825 856 851
Eu2l 861 851
Eu2 856 825 836
Eu2 848 814 836
Eu5 857 891 857
Eu5 849 894 857
Eu5 878 857
Eu5 891 777 857
Eu5 894 857
Eu5 878 857
Y31 915 756 913 1.1 913
Y31 914 913
Y31 911 913
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WA4 902 899 1.9 900
WA4 897 899

WA4 900 899

WA3 755 784 770 2.4 920
Eu20 766 802 797 1.7 797
Eu20 793 826 797 0.9 797
A2 776 776

A2 779 779

Y32 1.9 920
Y45 1.6 940
Y47 1.2 940
Y49 1.6 920
Eul0 0.2 900
849-36 0.0 820
Y4 2.1 920
Y4 1.0 895
Y5 1.8 895
Y12 0.9 895
Y19 0.7 900
Y19 1.1 913
WA3 1.4 920
WA4 0.7 899
Y32 1.6 895
Y45 1.9 920
Y46 1.2 920
Y47 1.7 920
Y49 1.6 920
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APPENDIX B: CORE LOG DETAILS

Depth | Depth | Geology notes (adapted from Drill Hole Log DD88ME-2 by Sample | Sample | Sample | Thin section notes

(m) (m) Palmer 1988) number | depth | depth

(from) | (to) (m) (m)
(from) | (to)

0 69 COVER SEQUENCE - interlayered sandstones and claystones

69 72 WEATHERED BASEMENT/ SANDSTONE

72 74.5 PORPHYRITIC DACITE/ RHYODACITE — brown to grey 2067545 | 73.2 73.3

weathered porphyritic intermediate volcanic consisting of
euhedral phenocrysts of plagioclase (25%) and subordinate k-
spar (15%) with fine laths of hornblende and biotite
distributed throughout. Fine crystalline quartz dominated
groundmass. Core is broken and there are numerous
crosscutting chlorite-serpentinite veinlets with minor iron
oxide and micro-brecciation/ fracturing.
74.5-94.9 m PYROXENITE WITH INTERLAYERED DACITE/
RHYODACITE AND DISCORDANT PEGMATITES AND RARE
DOLERITE
rock weathered to 81 m. core very broken and fragmented,
obscuring structure.

74.5 75.55 | PYROXENITE — dark green to grey, weathered, massive
medium crystalline pyroxenite comprising of altered
plagioclase and olivine (40%), euhedral amphibole (25%),
disseminated magnetite (10-15%) and scattered phenocrysts
of euhedral biotite (10-15%). Possibly up to 10% pyroxene.
Trace disseminated pyrite and chalcopyrite. Core broken.

75.55 | 76.3 PORPHYRITIC DACITE — brown to grey dacite (as for 72-74.5 2067546 | 77.05 77.15
m) with k-spar-quartz (biotite) pegmatite at 76.4-76.5 m and
chlorite and iron oxides lined fractures. Core broken.

76.3 84.12 | PYROXENITE — dark green to grey weathered massive medium
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Geology notes (adapted from Drill Hole Log DD88ME-2 by Sample | Sample | Sample | Thin section notes

Palmer 1988) number | depth | depth

(m) (m)
(from) | (to)

84.12

84.8

85.28

87

87.3

88.45

88.9
89.7

84.8

85.28

87

87.3

88.45

88.9

89.7
90

crystalline diorite comprising plagioclase (40%) and an
interlocking mass of euhedral amphibole (25-30%), magnetite
(10-15%), possibly pyroxene (5-10%) and biotite (10-15%)
minor irregular quartz and calcite veinlets. Trace pyrite and
chalcopyrite disseminated through rock. Discordant. K-spar-
quartz-amphibole pegmatite from 81-81.3

RHYODACITE — possibly discordant, comprising medium
crystalline phenocrysts of plagioclase (25%) and k-spar (45%)
which may be rotated (flow banding?) and subordinate quartz
(20%). Some vesicles and amygdales. Minor amphibole and
biotite. Well orientated chlorite between felspathic
phenocrysts. Core loss between 84.35-84.8 m.

DOLERITE (?) — weathered discordant plagioclase-amphibole-
k-spar-biotite dolerite, rock very friable

PYROXENITE — as for 76.5-84.12 m with thin (1-2 mm) siderite | 2067547 | 85.5 85.6
and quartz veinlets. Trace pyrite and chalcopyrite with veins.
Minor clay coatings on some fracture surfaces.

PEGMATITE — quartz-k-spar-plagioclase-(biotite-chlorite)
pegmatite. Medium to coarse crystalline, frequently
fractured.

PYROXENITE — as for 85.28-87 m. trace pyrite and
chalcopyrite

PEGMATITE — very coarsely crystalline, quartz (80%), k-spar
(15%) and biotite (5%). Trace chlorite. Discordant with lower
boundary

PYROXENITE — as for 85.28-87 m

Core loss

-Large ex-olivines
-intercumulate mica? (pleochroic
brownish)
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Palmer 1988) number | depth | depth

(m) (m)
(from) | (to)
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90
91

94.9

95.45
95.8

97.4

91
94.9

95.45

95.8
97.4

98.8

PEGMATITE — as for 87-87.3 m

PYROXENITE — as for 74.5-75.5 m, with discordant quartz vein
at 94.2 m and from 94.4 m chloritic/ serpentinitic alteration
of plagioclase and olivine within pyroxenite

94.9-112.88 m INTERLAYERED ULTRAMAFICS AND BASALT
WITH DISCORDANT PEGMATITE BANDS

series of interlayered basic volcanics with discordant
pegmatite bands. The basic volcanics are altered to
hornblendites near the pegmatite bands. Rock very fractured
and broken with quartz plagioclase veining and minor siderite
veinlets

HORNBLENDITE WITH PEGMATITE — dark to light green,
medium to coarse crystalline massive amphibole, altered
rock, comprising euhedral amphibole (25%) with fine grained
altered plagioclase. This appears to be an alteration halo to
small discordant irregular k-spar-quartz pegmatite bands
(contacts at 97.05-97.14, 95.27-95.3, and 94.45-95.5 m).
Minor siderite and quartz veining with traces pyrite.
PYROXENITE — as for 76.5-84.12

VESICULAR/ AMYGDALOIDAL BASALT — dark green-grey 2067548 | 97.05 97.15
massive fine-grained rock with groundmass of mafic minerals
and plagioclase. Irregularly scattered vesicles (1-3 mm) in
diameter, which may be quartz or carbonate filled. Trace
pyrite and chalcopyrite (97.1 m). Minor irregular quartz
veining. Trace pyrite and chalcopyrite on fracture planes.
PYROXENITE — as for 76.5-84.12 m, with moderate quartz/
carbonate (?) veining (carbonate does not react with acid).

-crystal digestion (quartz lumps,
scalloped edges indicate not
veining; evidence of AFC — basalt
digesting crust)

-unusually fresh phenocrysts of
pyroxene
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Depth | Depth | Geology notes (adapted from Drill Hole Log DD88ME-2 by Sample | Sample | Sample | Thin section notes
(m) (m) Palmer 1988) number | depth | depth
(from) | (to) (m) (m)
(from) | (to)
Small pegmatite band from 98.3-98.4 m
98.8 99.2 PEGMATITE — as above
99.2 99.68 | PYROXENITE — as above with thin pyrite veins and minor
carbonate at 99.5 m
99.68 | 99.86 | HORNBLENDITE — similar to 94.9-95.45 m, with k-spar (20%) 2067549 | 99.8 99.9 -phenocrysts of mica (probably
forming medium sized grains in ground mass with amphibole phlogopite)
(50%), biotite (15%) and minor plag (<5%). Minor chalcopyrite -olivine (green smudges in XPL,
as fine disseminated grains. Lower contact interpreted as likely broken down, easier to see in
alteration contact to pegmatite below PPL)
-clinopyroxene (bright blue in XPL,
equant crystals)
-lamprophyre
-Mg ad Krich
-delicately preserved texture
99.86 | 100.23 | PEGMATITE — k-spar-quartz-biotite rock with thin
amphibolitic margins
100.23 | 100.85 | PYROXENITE — weakly amphibolitic altered with carbonate
veining
100.85 | 101.63 | HORNBLENDITE — as for 99.68-99.86 m
101.63 | 106.45 | PEGMATITE — coarse crystalline felsic pegmatite consisting of
quartz (35%), k-spar (25%), microcline? (35%), and minor
biotite (5%), with minor amphibolitic xenoliths and
carbonate/clay veining. Minor amphibole-biotite-k-spar
veining
106.45 | 112.88 | PYROXENITE — dark green to grey, massive to very weakly 2067550 | 106.5 106.6

foliated, medium crystalline pyroxenite comprising plag (35-
40%), pyroxene (25-30%), magnetite (10-15%) and biotite (10-
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Depth | Depth | Geology notes (adapted from Drill Hole Log DD88ME-2 by Sample | Sample | Sample | Thin section notes
(m) (m) Palmer 1988) number | depth | depth
(from) | (to) (m) (m)
(from) | (to)
15%). Trace disseminated pyrite and rare chalcopyrite.
Abundant carbonate and quartz veining (some with clay) at
irregular orientations and serpentine
112.88 | 118.47 | PORPHYRITIC ANDESITE WITH MINOR DISCORDANT DOLERITE
BANDS — dark grey to grey-green porphyritic andesite
comprising of subhedral plagioclase phenocrysts (up to 2 mm;
30%), weakly orientated biotite laths (25%) and minor
hornblende (5-10%). Core now competent
118.47 | 119.05 | HORNBLENDITE — as for 94.9-95.45 m. possibly an alteration
halo to a pegmatite near hole. Indistinct contacts
119.05 | 122.85 | PORPHYRITIC ANDESITE — as above 2067551 | 119.05 | 119.1 -volcanic = looks like typical GRV
dacites
-zoned plagioclase phenocrysts
Ampbhibole phenocrysts (could have
been pyroxenes now altered to
amphibole but look like they could
be original)
122.85 | 123.8 | Medium grained k-spar-hornblende-biotite-plag with distinct
amphibole needles. Possibly lamprophyric-basalt related.
Traces pyrite and chalcopyrite
123.8 134.1 PORPHYRITIC ANDESITE — as for 112.88-118.47 m 2067552 | 125 125.1
134.1-146.2 m INTERBANDED PORPHYRITIC ANDESITE AND
PYROXENITE WITH MINOR DOLERITE BANDS
134.1 | 136.4 | PYROXENITE — grey-green, medium grained, plag-amphibole- | 2067553 | 135.7 135.8 -intercumulate clinopyroxene

biotite pyroxenite with traces of very fine grained pyrite and
chalcopyrite, thin irregular anastomosing chlorite/
serpentenite veinlets and minor irregular carbonate veinlets

(inclined extinction, orange XPL)
-olivine converted to serpentine
-more elongate grains also
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Sample | Thin section notes
depth

(m)

(to)

136.4

140.87

144.65
145.06

146.21

140.87

144.65

145.06
146.21

156.1

134.5-134.65 pegmatite band with chloritic or amphibolitic
alteration halo and traces chalcopyrite and pyrite
PORPHYRITIC ANDESITE — dark green to grey, fine grained
dacite with plagioclase and rare k-spar phenocrysts and small
biotite laths in very fine-grained quartzose groundmass. Rock
fractured by very thin carbonate (?) veinlets. Lower contact is
distinct with a chilled amphibolitic margin

PYROXENITE — grey-green to grey, medium-grained plag-
amphibole-biotite pyroxenite containing rare traced fine-
grained disseminated pyrite. Minor thin carbonate (?) veinlets
and chlorite veinlets. Minor chloritic alteration, possibly
related to dolerite dykes (?)

142.85-143.1 discordant hornblendite unit. Amphibole-
chlorite-plag-biotite rock, possibly altered. Minor k-spar
pegmatite remnant in centre, contacts gradational

ANDESITE — as for 136.4-140.8 m

ALKALI DOLERITE (?) — medium grained plag-k-spar- 2067554 | 145.4
amphibole-pyroxene-biotite rock with amphibole forming
distinct needles. K-spar usually forms in dominant sections.
Altered pegmatite or alkali dolerite (?). Rare pyrite as fine
disseminated euhedral grains. Distinct chilled upper contact
CARBONATE ALTERED PORPHYRITIC ANDESITIC ALKALI
BASALT — fine-grained, dark green-grey with small
phenocrysts of k-spar and plag often altered to calcite (1-3
mm size and elongate, forming a weak foliation). Ground
mass: very fine-grained mafic minerals and minor biotite.
Lower contact chilled and irregular

serpentinised may have been
orthopyroxene

145.5
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Sample | Thin section notes
depth

(m)

(to)

156.16

158.1

167.3

158.1

167.3

170.7

149.59-150.43 medium grained doleritic band with k-spar
veinlets and xenoliths.

150.43-153.4 more andesitic interval with angular k-spar
quartz gneiss and pyroxenite xenoliths. Rare thin carbonate
veins

ANDESITE — fine-grained, light grey with k-spar and plag and 2067555 | 156.35
rare biotite laths, in a quartzose groundmass. Rare thin
chlorite veining. Indistinct lower contact. Core fractured
CARBONATE ALTERED PYROXENITE — medium-grained, dark 2067556 | 166.15
green-grey diorite consisting of equigranular mass of
plagioclase, olivine (?) and laths of biotite with traces of very
fine-grained disseminated euhedral chalcopyrite, variably
altered by carbonate (calcite) replacing plag within rock and
numerous thin veinlets which may contain chalcopyrite
158.1-159.35 pyroxenite contains extensive chlorite veining
159.35-159.5 thin pegmatitic band with chloritic or
amphibolic alteration halo of surrounding pyroxenite
163.75-165 moderately carbonate altered section

165-167.3 strongly carbonate altered section

CARBONATE ALTERED PORPHYRITIC ANDESITIC BASALT WITH
GNEISS XENOLITH — dark grey, very fine-grained andesitic
basalt with small phenocrysts (up to 1 mm) of carbonate
(after plag) in a mafic ground mass. Minor traces
disseminated pyrite and chalcopyrite. Thin carbonate veinlets
throughout. Phenocrysts form a vague lineation. In parts the
basalt contains xenoliths of k-spar-quartz gneiss
170.25-171.7 xenolith (?) of medium- to fine- grained, well

156.4

166.25
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Sample | Thin section notes
depth

(m)

(to)

170.7
172.75

182.2

172.75
182.2

199.3

foliated, quartz-k-spar-biotite-amphibole gneiss (?) with
coarse-grained k-spar-quartz segregations, wisps and bands
parallel to foliation. Traces pyrite and at 170.8-170.9
carbonate altered dolerite with chilled margins. Irregular
contact

BRECCIA/ SHEAR ZONE

CARBONATE ALTERED PYROXENITE — grey to grey-green,
medium-grained pyroxenite, weak to strongly carbonate
altered with carbonate replacing plag grains, shattered in
parts by fine networks of calcite veinlets. Rare k-soar-quartz-
amphibole pegmatite bands (up to 15 cm thick) with distinct
chloritised pyroxenite margins (up to 15 cm wide). Rare traces
pyrite and chalcopyrite as disseminated grains

172.75-173.7 strongly carbonate altered and veined interval
175.05-176 strongly carbonate altered section

176-176.15 pegmatite band with traces pyrite and chloritic
altered pyroxenite margins

176.15-177.3 strongly chlorite and amphibolitic (?) altered
section with minor biotite and chalcopyrite

179.15 thin carbonate veinlet with pyrite and pyrrhotite blebs
178-180.2 less altered pyroxenite

180.2-180.55 carbonate and chlorite altered pyroxenite with
chlorite veinlets

CHLORITE ALTERED PYROXENITE — medium-grained, grey-
green, biotite-plag-amphibole-chlorite pyroxenite with rare
pyrite, chalcopyrite, and pyrrhotite as disseminated grains
throughout. Minor talc coated joints. Pyroxenite variably
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Sample | Thin section notes
depth

(m)

(to)

chloritically or amphibolitic altered throughout. Minor k-spar-
guartz pegmatite bands with intensely chloritised haloes
182.2-185.1 strongly to totally chloritised section with
carbonate veinlets and amphibole-rich sections. Minor talc,
with fractured and brecciated quartz vein from 183-183.5
187.7-187.8 thin k-spar/ quartz band with chloritic alteration
haloes

188.7-189.6 very strongly chloritic and talc altered sections
190-191.15 very strongly chloritic section

191.15-191.75 k-spar-quartz pegmatite band

191.75-193.3 strongly chloritic and carbonate altered
pyroxenite with thin carbonate veinlets

193.3-193.7 pegmatite band

193.7-196.3 moderate to strong chloritic altered and
moderate carbonate altered pyroxenite, rare traces
chalcopyrite and moderate thin carbonate veinlets
196.3-199.3 weakly chloritically altered pyroxenite
199.3-302.5 m PYROXENITE WITH K-SPAR-QUARTZ
PEGMATITE BANDS AND RARE DOLERITE

medium-grained, dark grey to grey-green, amphibole-biotite-
plag pyroxenite. Weakly chloritically and carbonate altered in
parts. Traces disseminated chalcopyrite and pyrite
throughout. Minor to moderate, thin irregular carbonate
veinlets. Minor talc on joint facings. Pyroxenite fractured and
altered by k-spar-quartz pegmatite bands, pyroxenite next to
pegmatite bands intensely chloritised. Very rare xenoliths of
quartz-k-spar porphyry and k-spar-quartz-biotite gneiss.

2067557 | 201.5

201.6
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Depth | Depth | Geology notes (adapted from Drill Hole Log DD88ME-2 by Sample | Sample | Sample | Thin section notes
(m) (m) Palmer 1988) number | depth | depth
(from) | (to) (m) (m)
(from) | (to)
203.5 | 205.3 | chloritic altered section with discontinuous pegmatite bands
to 20 cm thick
205.3 | 206.4 | chloritic altered section with thin carbonate veinlets
206.4 | 206.7 | asat203.5-205.3
206.7 | 209.6 | pyroxenite
209.6 | 212.3 | intensely chloritised section with discontinuous wisps and
bands to 50 cm of quartz-k-spar-biotite-chlorite porphyry.
Porphyroblasts of k-spar to 4 mm. biotite forms a crude
foliation with maybe contorted in parts
212.3 | 220.2 | pyroxenite 2067558 | 218.8 218.9
220.2 | 220.7 | chloritised pyroxenite with pegmatite bands containing talc
221.1 quartz-talc band
222.3 | 223.8 | Chloritised pyroxenite with irregular pegmatite bands. Minor | 2067559 | 223.8 223.9
talc
223.8 | 227.8 | pyroxenite with chloritically altered sections surrounding
pegmatite bands to 30 cm thick
230.15 | 230.35 | pegmatite band with chlorite halo
231 231.3 | as above
231.75 | 231.9 | as above
2329 | 233.6 | Asabove
243.4 Thin pegmatite band
235.6 As above
236.9 | 239.8 | Pyroxenite chloritically and carbonate altered in parts with
pegmatite bands at 237-237.1 and 238.25-238.45. talc with
pegmatite bands
240.7 | 240.75 | pegmatite band with chlorite alteration haloes
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Depth | Depth | Geology notes (adapted from Drill Hole Log DD88ME-2 by Sample | Sample | Sample | Thin section notes
(m) (m) Palmer 1988) number | depth | depth
(from) | (to) (m) (m)

(from) | (to)

241.7 | 241.85 | As above

242.1 | 242.3 | Asabove

244.3 | 244.7 | As above

245 245.15 | As above

245.75 | 246.2 | As above

246.2 | 247.8 | weak to moderate carbonate altered pyroxenite with thin 2067560 | 247.1 247.6
carbonate veinlets containing traces chalcopyrite

247.8 | 248.1 | distinct fine-grained mafic band with chloritised garnets (?)

248.1 | 249 carbonate altered pyroxenite

249 250.75 | Dolerite (?) medium- to fine-grained, green-grey, feldspar-
biotite-pyroxene rock with clasts of k-spar-quartz-biotite
gneiss. From 250 m amphibole phenocrysts

250.75 | 252.5 | strongly chloritically and variably carbonate altered
pyroxenite with clasts and wisps of k-spar-quartz gneiss

2525 | 257.7 | pyroxenite

257.5 | 257.6 | fractured quartz chlorite vein or band

259.75 | 260 pegmatite band

260 260.6 | Chlorite altered pyroxenite

260.6 | 269.05 | pyroxenite 2067561 | 267.1 267.2

269.05 | 269.1 | quartz-plag-amphibole-chlorite pegmatite band

269.1 | 270.6 | Pyroxenite

270.6 | 270.7 | amphibole-plag-quartz-carbonate pegmatite band

270.7 | 279.9 | pyroxenite

279.9 | 282.3 | very weakly chloritically altered pyroxenite with chlorite-plag
vein at 280.9-281.1 m

282.3 | 285.4 | Pyroxenite
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Depth | Depth | Geology notes (adapted from Drill Hole Log DD88ME-2 by Sample | Sample | Sample | Thin section notes

(m) (m) Palmer 1988) number | depth | depth

(from) | (to) (m) (m)

(from) | (to)

285.4 | 287 core fractured with weak carbonate alteration and veining

287 292.55 | pyroxenite with fine wispy carbonate veins

292.55 | 294.6 | pyroxenite with rare thin chloritic shear zones and weakly

chloritic altered

294.6 | 295.9 | Pyroxenite

295.9 | 296.4 | k-spar-quartz pegmatite band

296.4 | 300.3 | pyroxenite 2067562 | 297.8 297.9 -olivine altered to serpentine (clear
mineral with dark black spots/lines,
pale blue in XPL)
-cumulative texture
-orthopyroxene islands in
clinopyroxene (brownish in XPL)

300.3 | 303.1 | carbonate altered pyroxenite

301.1 | 302.5 | pyroxenite

302.5 END OF HOLE
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APPENDIX C: FULL METHODS

Choosing core and taking samples

SARIG was used to find drillholes that intersected GRV, with assistance from Claire
Wade. These were then further assessed for rock types that were intersected, with
particular interest in those holes that showed progression from mafic, through
intermediate, to more felsic rocks. Those that showed some variation were looked
at more closely using existing drillhole logs and reports available on SARIG. One was
found to be suitable, with pyroxenite grading through andesite and dacite to a
rhyodacitic material, with interlayers of basalt. While the available information
suggested the core was moderately altered throughout, this was the most ideal
hole to use based on the succession. This hole is located on the Labyrinth 1:50K
(Kingoonya 1:100K) map sheet, on the north-western edge of Lake Labyrinth, near
Kingoonya, SA.

The core was requested for inspection at the Glenside Core Library. During
inspection, the core was roughly re-logged, using the existing log as a guide. This
was done using a pencil and gridded paper on a clipboard, with the aid of a hand
lens and a spray water bottle to make minerals easier to identify. Overall, not much
was written on this log, as the existing log contained almost all the relevant
information, though some rock-type identification required updating. Eighteen
samples were chosen based on two main criteria: rock-type variation, and lack of
veining. The desired samples were marked and labelled, before being cut by the
staff at the core library. Removal of the samples from the core library was under the
provision of the Mining Act 1971 and the Sample Removal Conditions set out by
DMITRE.

Six polished thin sections were made from the samples taken from the core. The
samples used were 2067547, 2067548, 2067549, 2067551, 2067553, and 2067562.

A transmitted light microscope was used to look at the thin sections.

Previously prepared samples

Due to the nature of this project, building on the work of Stewart (1994), some

previously analysed and prepared samples were able to be reanalysed without extra
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preparation time. Nine thin sections were analysed with the microprobe, to give
more information about phenocryst compositions versus groundmass compositions.
Previous geochemical analyses were also used to provide input for modelling
programs.

In additions to this, two mineral separates were obtained from another honours
student, Max Reddy. These were from GRV rocks that contained abundant zircons.
The zircons were mounted and CL images were taken before lasering the zircons.
This was done in two stages, to obtain age estimates and also trace element

abundances.

General sample preparation

The samples taken from the core were used primarily for geochemical analysis from

powders. The procedure was as follows:

JAW CRUSHER

1.1
1.2.
1.3.
1.4.
1.5.
1.6.

1.7.
1.8.

To reduce the samples to chips and powder:

Clean — using compressed air, a wire brush, and ethanol and paper towel, checking
for any caught fragments and dust

Blow off top with compressed air

Open top and middle door of housing, open jaws and blow off each section

Scrub jaws with wire brush

Blow off any loosened dust

Check for lodged fragments and remove with hacksaw blade if necessary

Squirt with ethanol and wipe with paper towel to geochemically sterilise the jaw/
teeth

Blow off again to dry out any remaining ethanol

Remove collection tray, blow out and wipe with ethanol and paper towel

Close jaws and lock in place with the side screw-wheel

Place paper at front of collection tray, slide back into place

Check spacing of jaws — adjust if necessary by using the wheel at the front of the
jaws

Close doors of the crusher housing and lock
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Turn on using the green START button

Drop sample into opening at top, quickly closing the chute to prevent fragments
escaping

Listen for crushing of sample

Turn off using red STOP button when crushing sounds have stopped

Unlock doors and open

Remove catcher with sample in it

Use paper to lift crushed sample out

Place sample on paper aside, repeat cleaning steps

VIBRATING MILL (10G TUNGSTEN CARBIDE MILL HEAD)

2.1.
2.2.

2.3.
2.4.
2.5.

To reduce crushed sample to a fine powder.

Locate correct mill vessel size — due to size of samples from core, the 10g mill head
is used

Clean mill pieces — using compressed air, ethanol and paper towel — starting with
the main bowl so that the puck can be placed inside once it is clean, rather than on
the bench where it may be contaminated

Blow off with compressed air

Squirt with ethanol and wipe with paper towel to geochemically sterilise the mill
pieces

Blow off again to ensure pieces are dry

Run mill with quartz before sample to ensure any contamination will be known
Clean again after each sample

Pour crushed sample into the mill between the puck and the edge of the bowl,
wiping off any that falls on top of the puck — some samples were milled in two
stages, as they were a little too big to be milled in this size vessel all at once, but still
not big enough to go up to the next vessel size

Place lid on, ensuring that it is on properly so no sample will escape

Check correct sized base is on the vibrating mill, so that the vessel can be securely
clamped down

Place vessel on base — layer piece of rubber and carpet on top to ensure clamp will

be firm
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7. Clamp down the mill with the handle, ensuring the rod goes between the notches
and folds down securely (keep in place by sliding up the zip tie)
8. Close the lid of the housing
9. Set timer (e.g. for one minute)
10. Press start
11. When finished, wait for machinery to stop moving, then open housing
12. Unclamp and remove the mill vessel and carefully open, with the aid of a hammer if
necessary, without spilling any of the powder
13. Tip powder and puck onto clean paper
14. Remove puck and place in main bowl
15. Check powder for fineness and consistency of fineness
15.1. If not milled completely (still feels gritty when rubbed between two
fingers), pour back into mill and run again
15.2. If milled sufficiently, pour sample into clean and labelled sample bag
16. Repeat cleaning steps
16.1. If sample cakes, can run mill with quartz to aid cleaning

ZIRCON MOUNTS

5.1.

w N o

Some zircons from the mineral separates taken from Max Reddy were mounted
using the following procedure:

Clean glass slide with ethanol and tissue

Stick piece of double-sided tape on glass slide (as much as possible, prevent or
remove bubbles). Keep backing

Place piece of single-sided tape over double-sided tape (sticky side up) and use
backing from double-sided tape to smooth out bubbles

Use silicon mount (inside rim) to trace a circle into the glue on the tape with the
pick (this is where zircons will be mounted), choose an area that is most smooth
Clean a petri dish with ethanol and tissue

Cover base of dish with ethanol, tip in bin and wipe dry with tissue

Tip mineral grains into the petri dish

Set up two binocular microscopes close together

Place the petri dish of grains under one and glass slide with tape under the other

Position the glass slide so that the circle that was traced in the glue can be seen
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10. Use a pick (touch on face to make oily so grains will stick) to pick up zircons and
transport them to the sticky circle
10.1. Make 3 lines of zircons relatively close together, but not touching
11. Use double-sided tape backing to cover the zircons until ready to glue
12. Print off short labels (size 9 font) and cut out
13. Prepare glue
13.1. Mix 5g of epoxy resin with 1g of hardener for each mount (2 mounts = 10g

of epoxy resin, 2g of hardener — can be prepared together)

13.1.1. Place plastic cup on scale (cover scale with paper towel to assist clean up if
spill occurs)
13.1.2. Tare scale
13.1.3. Pour 10g of resin into cup
13.1.4. Tare scale
13.1.5. Pour 2g of hardener into cup (use a second cup to assist slow pouring)
13.1.6. Mix well with pop stick
13.1.6.1. Will become cloudy, then clear again (clear = ready)
13.1.6.2. If bubbles appear, heat for 2 minutes in low temperature oven (bubbles will

rise to the surface and pop)
13.2. When glue is sufficiently mixed, remove backing tape from glass slides and
place silicon moulds over the area where zircons are mounted
13.3. Slowly pour glue into moulds until at approx. 1cm thickness
13.4. Carefully place sample labels onto the surface of the glue with tweezers
(sample name/number up)
13.5. Leave to set overnight
14. Polish mounts
14.1. Polish side with zircons
14.2. Use 1000 grit paper by hand for approx. 2 minutes in figure 8 patterns to
ensure even polishing
14.2.1. Check surface under binocular microscope and continue polishing until
surface of zircons is at surface of mount
14.3. Use 2400 grit paper by hand in figure 8 patterns until surface is evenly

smooth and as many zircons as possible are exposed at the surface
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14.4. Use the cloth lap to polish mount surfaces more (follow available
instructions about which cloth to use with which diamond paste)

14.4.1. Use the blue cloth (3um) with green diamond paste for about 10 minutes
on low speed

14.4.2. Use the brown cloth (1um) with blue paste for about 10 minutes on low
speed

14.5. Clean mounts with ethanol and tissue, also advisable to use a sonic bath for
5+ minutes to remove as much diamond paste as possible

14.6. Worap clean and polished mounts in Kimwipes for transport

Analyses

As the goal was to run the Rhyolite-MELTS program, the information required for
the program was obtained. This includes major and trace element analyses. Interest

was also in REE values.

PHILIPS XL40 SCANNING ELECTRON MICROSCOPE - CL IMAGING OF ZIRCONS

1. Getting started
1.1. Dual monitor set up — monitor on right known as XL Control (for movement of
stage, turning on the electron beam, etc.); monitor on left used for acquisition of
EDS spectral data
1.2. On the XL Control monitor, double-click the ‘Microscope control’ icon. Microscope
control screen will appear
2. Inserting sample
2.1. Ensure sample holder is at maximum working distance by selecting 40 mm from the
drop down menu and the “GoTo” button
2.2. Then go to the vacuum control group and click ‘Vent’ button
2.3. Wait approx. 2 minutes before attempting to open the door using the bar on the
bottom of the front of the chamber. If the door does not budge, the chamber is still
venting.
2.4. Insert a sample or samples into appropriate holder and use carbon tape to secure

2.5. If the backscatter detector is required, check that it is inserted correctly
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2.6. Close door and hold closed while selecting ‘Pump’ button from the vacuum control
group

2.6.1.1f a whooshing sound is heard, the door is no closed properly. Lift and push the door
slightly

3. Obtaining an image

3.1. Before turning the microscope one, in the ‘Microscope Control’ window, use the
pull-down menus to select operating parameters suitable for the sample to be
examined

3.1.1. Beam: from this menu, you can select the required acceleration voltage and spot
size required for your samples. Typically, low kV for non-conducting samples (5-10
kV) and medium to high kV (15-20 kV) for conducting samples. Spot size indicates
how much current is applied to the sample, and for initial magnification viewing
should be set around 4 or 5

3.1.2. Maghnification: this menu selects the magnification of your sample. Initially it is best
to use the lowest magnification possible. Magnification can also be adjusted with
the + and — keys on the number pad of the keyboard. If different default
maghnifications are required they can be adjusted with the ‘Magnification presets...’
option in this menu

3.1.3. Scan: this drop down selects the speed at which the electron beam rasters across
the field of view (equivalent to the refresh rate of a monitor). For initial viewing
purposes, select ‘TV' mode which is approximate to real time viewing of the sample.
Note: if using the backscatter detector, NEVER use TV mode as damage to the
sensitive detector may occur. Always use slow scan 1, 2 or 3 with BSE mode (see
section 3.1.3). For imaging purposes, slower scan rates are selected to improve
picture quality (see section 4 — optimising the image). In addition to this, the user
has the option of selecting the Scan mode. For general viewing purposes, this
should be set to full frame, however specific tasks, such as general image
optimisation, will require different modes (see section 4 — optimising the image)

3.1.4. Detectors: this menu allows the user to select which detector is to be used. For
initial start-up, before the electron beam is turned on, the secondary electron
detector (SE) should be selected.

3.1.4.1. Secondary electron detector (SE): secondary electrons are very low energy

electrons (<50 eV) emitted from the outer shell of atoms comprising the material of

65



Jade-Starr Tregeagle
Petrogenesis of the Gawler Range Volcanics

interest due to excitation by the primary electron beam. Due to their low energy,
only secondary electrons from the first few atomic layers of the material (few nm)
can escape and as such SE mode reveals information on surface topography of the
sample. Secondary electrons from topographic highs are more easily emitted and
do not have to travel as far to the SE detector, thus appear as bright spots, and
conversely topographic lows appear as dark regions due to the lower number of
electrons emitted

3.1.4.2. Backscattered electron detector (BSE): incident electrons from the electron
beam can also be elastically scattered by close encounters with the dense atomic
nuclei. As such back scattered electrons are high energy electrons scattered from
atoms up to about 50 nm below the surface of the sample (measured in keV — they
have approx. the same energy as the incident electron beam). As a result, BSE mode
reveals information on the Z contrast of your sample (Z=atomic number) where
regions that contain material with a high Z will be viewed as bright regions and
conversely atoms with a low Z as dark regions. Note: make sure TV mode is NOT
selected under the scan menu

3.1.4.3. CCD camera: this option will display an image of the inside of the sample
chamber via the CCD cameras mounted on the XL40. This option is useful when
rotating the stage or adjusting the sample height to make sure you are not driving
your sample into the pole piece or backscatter detector if mounted. The CCD

camera is vital when employing the cathodoluminescence (CL) detector (see section

7 —CL imaging)
3.1.4.4. IMG: again, this option is used for CL imaging and is explained in section 7 —
CLimaging

3.1.5.Filter: from this menu, the user can select the frame store noise-filtering mode. As a
general rule, is using slow scan speeds, the live noise filtering mode should be
selected and if using TV mode, then average 4 and standard definition can be
selected.

3.1.6. Once all these settings have been selected, we are now ready to turn the electron
beam on

3.2. Control Area
3.2.1.Settings: once the vacuum is sufficient to turn the electron beam on, the ‘Vac OK’

status is indicated in Vacuum Control Group. Make sure that the SE detector is

66



4.1.

Jade-Starr Tregeagle
Petrogenesis of the Gawler Range Volcanics

selected then click on the kV button (in Beam control group) to turn the beam on.
Once turned on, this button will be highlighted yellow and an image should appear
on the screen. If screen remains black, the contrast and brightness settings may
need to be adjusted. As a starting point, adjust the contrast and brightness using
the automatic contrast and brightness (ACB) button (in button bar or button in
Settings control group). The sliding controls in the Settings control group can also be
used. Note: ACB cannot be used if the backscatter detector is selected. When the
beam is turned on, a dialogue box ‘Microscope confirm focus’ will appear in the
screen. After finding the highest part of the sample, increase magnification to 500
or more. Carefully focus the image (see section 4.3) and press OK in the dialogue
box. This links the working distance (WD) in the data bar to Z height in the stage
control group. Note: it is very important to carry out this procedure before
proceeding in order to avoid possible damage to the microscope or sample when
changing working distance. Once the working distance is calibrated, drive the stage
to the optimal height of 10 mm from the Z drop down box and ‘GoTo’ button (for CL
(see section 7) this height must be no closer than 15 mm for best results, use a WD
of 15-16 mm).

Optimising the image

Adjusting contrast and brightness: as a starting point, it is good to use the ACB
function. However, the contrast and brightness can be adjusted manually via the
slider bars on the ‘Settings’ and ‘Stage’ tabs of ‘Microscope Control’, and it is
recommended that these are utilised to obtain the optimum image for the material
of interest. If the sample of interest displays large contrasts of shades of grey, one
method to optimise your image is by using the Horizontal Line function. Navigate to
a feature of your sample that contains the largest contrast variation and select the
Horizontal Line function and Slow Scan 3 from the Scan drop down menu. The
screen will now display a solid white horizontal line bounded by two dashed white
lines, along with a spiky white line. The incident electron beam is now scanning
along the solid white line, and the spiky white line is an output of the “brightness”
of the pixels along that solid white line, where the uppermost dashed white line
represents pure white, and the lower pure black. Generally, you want the spike
bright line to sit just within the bounds of the upper and lower dashed lines to

maximise the contrast of your image to pull features out, while minimising areas of
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pure white and black. As such, the ‘Contrast’ slider bar will stretch the spiky white
line, and the ‘Brightness’ slider bar will shift it up and down. Once this is done, click
“Save ACB Settings”

Moving the sample: to move around your sample, select the ‘Track’ button in the
button bar (looks like a target with a line coming out to one side). Place the cursor
between two concentric circles, and hold down the LH mouse button. The sample
will move in the direction of the vector. The speed of movement is proportional to
the distance of the cursor from the inner circle. Move to a section of sample that
displays some detail that can be focused on.

Rotating the sample: to rotate the sample, open the ‘Stage’ control group in the
‘Imaging’ control area (arrow in top RH corner). By moving the sliding control, the
sample can be rotated in either direction. The speed of the rotation is indicated by
the arrows above the control. The image of the sample can also be rotated by using
the ‘Scan rotation’ sliding control. In addition to this, the coordinates of locations of
interest can be stored if you need to return to them. Simply type in the label you
would like to give the position and click ‘Add’. A cross in the stage schematic will
mark the positions located. To return to a position simply double click on the name
of the positon in the list.

Focusing: once the beam is turned on, the image needs to be focused. To do this,
zoom out to the lowest magnification and hold down the RH mouse button
(horizontal double arrow appears). Whilst holding down the RH mouse button,
move the mouse slowing left or right until optimum focus is achieved. Once this is
done, repeat the steps of zooming in and focusing until image is focused at required
zoom of work. Note: Slow Scan 1 should be used whilst focusing to obtain optimum
image.

Astigmatism correction: Ideally, when the electron beam hits the surface of your
sample it should have a circular cross-section. However, due to the effects in the
lenses and/or contamination in the column, the beam can vary in shape and
commonly forms an ellipse. This is called astigmatism, and the higher
magnifications can produce artefacts in the image obtained. As such, astigmatism
must be corrected before the best possible image can be obtained. To correct for
this, we apply a magnetic field to the electron beam to adjust its shape. Focus at

high magnification as described above. Click and hold the LH mouse button in the
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‘Stigmator’ box (‘Imaging’ control group), which will display cross hairs over the
image. Move one cross hair over the image until the clarity improves. Then, while
holding position of the cross hair, repeat the process with the other cross hair.
Refocus the image. Astigmatism can also be adjusted by holding down the Shift key
while holding down the RH mouse button.

To tilt the sample: if tilting of sample is required, open the ‘Stage’ control group in
the ‘Imaging’ control group and adjust the value of T (tilt). As you are tilting, make
sure not to crash your sample into the pole piece of the backscatter detector if
installed. As a guide, do not tilt over 26 degrees. Make sure the CL detector is
retracted before tilting.

Image storage

Data bar: in the ‘In/Out’ menu, select ‘Databar Setup’. The information in the data
bar can be altered by selecting or deleting various items. A text box is displayed, in
which information about the sample can be entered. If the ‘Background’ box is
selected, the data bar will appear as white writing on a black background. If not, the
background will be clear. When complete, click on ‘OK’.

Storing the image:

5.2.1.In the ‘In/Out’ menu, select ‘Image’

5.2.2.Select the TIFF file option, and in the textbox type in a filename up to eight

characters long in place of the * symbol. Note: no spaces are allowed in the file

name.

5.2.3.Click on the ‘Save’ button. A time-lapse bar will appear, and the image will be saved

5.3.

6.

6.1.

to the server. The screen will be restored to normal when the function is complete.
Note: if the information in the data bar is required for images that are to be
accessed remotely, click on the ‘Databar on image’ box before saving. The data bar
will then become a permanent part of the image

Restoring an image: to review images already stored, select ‘Image’ in the ‘In/Out’
menu. Select the required image from the file by clicking on it, and it will appear in
the text box. Click on the ‘Restore’ button, and the stored image will be displayed.
CLimaging

Sample insertion

6.1.1.Make sure the stage has been lowered to 40 mm and vent the XL40 chamber as

described in Section 2. If not already done, make sure the stage is at O degrees tilt
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and the CL detector is wound all the way out (turn blue knob on the Gatan CL
detector fully clockwise)

6.1.2.0pen the door and insert the sample. Close the door and ‘Pump’ the vacuum
chamber as described in Section 2. When ‘Vac OK’ has been achieved, turn on the
kV (use 12kV, spot size 7). Select SE from the ‘Detector’ drop down menu and turn
the beam on (as described in Section 3.2.1)

6.2. Focusing

6.2.1.Move around to the desired area of interest and focus on your sample as clearly as
possible, then link the working distance

6.2.2.Select ‘CCD’ from the ‘Detector’ pull down menu and bring the stage up to 15-16
mm (no closer than 15 mm) by changing Z and clicking ‘GoTo’. Watch the CCD
camera view as the stage is raised

6.2.3.Again, focus on your sample as clearly as possible, then link the working distance
(WD). Then change Z to 16-16 mm again and click ‘GoTo’

6.2.4.While watching the CCD camera view, wind in the CL detector (turn the blue knob
on the Gatan CL detector counter clockwise), making sure that there is enough
clearance between the CL detector and the top of your sample. The gap between
the detector and sample should be very small (around mM) but there needs to be
one. If it looks like it will collide with anything, you will need to wind the CL detector
back out, refocus, relink the WD, change the stage height to a higher value (over 15
mm), and try again. The height of the sample will need to be adjusted such that the
sample surface is 7.66 um (Y direction) using the measurement tool with the
Microscope Control software

6.3. Imaging

6.3.1.Select ‘Slow Scan 3’ from the ‘Scan’ drop down menu, and ‘IMG’ from the ‘Detector’
drop down menu

6.3.2.0n the CL power panel, turn the power on by hitting the ‘Power’ switch at the top
LH corner of the panel, and increase the HT to between -500 and -650 until an
image appears (around -600 is usually OK, but do not exceed -650)

6.3.3.Adjust the brightness and contrast of the image using the Horizontal Line scan
function as explained in Section 4.1, however use the brightness and contrast knobs
on the CL control unit instead of those within Microscope Control

6.4. Closing down CL
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6.4.1.Decrease the HT on the CL detector control back to zero

6.4.2.Power OFF the CL detector

6.4.3.Ensure that the CL detector is wound all the way out by turning the blue knob on

the Gatan CL detector fully clockwise

6.4.4.Vent chamber and remove sample as per shutdown procedure detailed in Section 7

7. Closing down

7.1. Make sure the SE detector is selected and turn beam off by clicking on kV button in
‘Beam’ control group

7.2. Drive the stage down to its maximum working distance of 40 mm. vent chamber by
clicking on the ‘Vent’ button. Once vented, door will not open automatically and as
such after approx. two minutes gently attempt to open the door using the bar on
the bottom of the front of the chamber. If the door does not budge, the chamber is
still venting.

7.3. Remove samples from the chamber

7.4. Close the door and ‘Pump’ the chamber — wait until ‘Vac OK’ status is indicated

7.5. Close Microscope Control software

7.6. Collect data by copying to a USB drive

LA-ICP-MS

1.1.
1.2.

1.3.

1.4.

1.5.

This methodology was performed on the zircon mounts.

Inserting samples

Ensure ICP-MS is in standby mode

Loosen the screws on the laser ablation chamber door and slide the door to the left.
The sample holder will then slide out

Clean samples with ethanol and Kimwipes (remove as much carbon coating as
possible)

Place samples into the cells of the sample holder, ensuring the samples are held
securely and tops of the samples are level with the top of the holder (otherwise
camera will not focus properly — can use Blu-tack and coins to bring up, or grind the
base down if too high)

Insert the sample holder into the chamber, close the door and tighten the screws
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Getting started and turning on gases

The operation of ICP-MS for laser ablation studies requires the user to setup two
separate systems to use concurrently. There are three computers at the use
console: left computer controls the Glitter Data Processing software (known as the
Glitter Computer); the middle computer controls the ICP-MS through the ICP-MS
Top software (known as the Chemstation Computer); and the right computer is
used to view the samples and operate the laser ablation system (known as the
NewWave Computer).

Start ICP-MS Top program [Chemstation Computer]

Select “Instrument Control” from the Instrument menu. Check the displays in the
bottom of the screen and ensure the Argon Gas pressure reads above 500 torr
(advise staff if it does not)

Select “Maintenance menu” then “Sample Introduction”

Check box “Optional Gas” and type 60% for “Optional Gas” and click on Enter
Open “Laser Ablation” program on the NewWave computer

Ensure “Online” is selected

Click on “Evacuate.” A dialogue box will pop up with a status bar, indicating the
number of cycles. The laser ablation chamber is being evacuated and then refilled
with He in cycles

Once finished, click “Evacuate” two more times. The system needs to do a total of
30 cycles to remove all the air from the chamber (each time does 10 cycles)

Close “Sample Introduction” dialogue on the ICP-MS Top program. This will reset
the optional gas to 0%

Turning on the plasma

In ICP-MS Top program, select Instrument > Tune

Select “Optional Gas” slider bar (probably set at around 58%) and turn it down to
20%

Select Instrument > Instrument Control

Select Instrument > Instrument Control > Start Plasma

When the plasma is ignited, the Chemstation will change mode of the system from
Start Up mode to Standby mode. This can take a few minutes. If for some reason
the plasma is extinguished the mode of the system will default back to the former

mode, which will also take a few minutes.
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Wait until the plasma is fully operational (all gauges green — approximately 2
minutes)

Go back to Instrument > Tune and turn Optional Gas back up to correct value
(usually 58-59%)

May need to wait up to half an hour for the plasma to stabilise. This is a good time
to set up the method and save the locations of samples

Load method

The method is the experimental parameters used by the mass spectrometer on the
ICP-MS. It includes the elements to be analysed, the acquisition mode and
acquisition times

On the Chemstation computer select the Methods menu > Load

Select BenZirc.M for zircon dating, JTZirc.M for trace elements in zircons and click
ok

Choose the equivalent calibration file (with a C extension) and click ok (In Laser
Ablation mode the calibration file is not used however the software will still require
this file, if no equivalent calibration file can be found then select Default.C)

Setting up the laser ablation system

Open “Laser Ablation” program on the NewWave computer

Turn up light intensity and choose COAX mode of sample illumination

Choose 5 Hz for laser fire frequency/ rate

Select laser spot size 30 um

Select power rating 80%

In order to view the sample surface, the user can adjust the optical zoom. To locate
samples use a zero value for the optical zoom, when using the laser increase the
zoom to 50%

Saving the positions of standards

Standards used were the NIST Standard Block (NIST 610 and 612), Zircon Standard
Block 1 (GJ and Plesovice), and Zircon Standard Block 3 when Block 1 was
unavailable (GJ and BJWP)

Locate a standard, click “Position” button > name position > “set to current stage
position” > “Add”

Do the same for the first points of your sample blocks
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If the position of a standard or sample changes, select the relevant positon from the
list and click “Edit” > “Set to current stage positon”

Tuning the plasma: P/A Factor

Tuning of the plasma, lens, and detector system is extremely critical for the equality
of results. Once the plasma has been lit, the system is monitored using the
Instrument Tune panel. Counts of Ar-Ar at mass 80 are used to determine the
stability of the plasma. Hit the START button on the Instrument Tune panel to
obtain mass signals. Stable counts of mass 80 higher than 2 million indicate that the
plasma is stable.

The P/A Factor allows the ICP-MS software to process signals acquired by the
detector in pulse count mode and analogue mode with seamless/ linear calibration/
this transition in the way the signal is measured occurs when counts per second
exceed approximately one million. Thus the P/A Factor is not required every time
the system is run, only when you expect cps to exceed approximately one million in
your unknown (note: always perform P/A Factor if attempting geochronology, as
counts per second in zircon and monatzite typically exceed one million). When
conducting a P/A Factor, what we are attempting to do is trip the detector into
analogue counting mode by obtaining over one million counts in at least two
elements at opposite ends of the mass spectrum you are analysing. We do this by
increasing the spot size and intensity of the laser, and ablate a high concentration
NIST glass.

Move to NIST 610 (dark blue glass)

Initially, change the beam to 65 um and increase frequency to 10 Hz (85% laser
output)

To view counts on the detector of specific isotopes click the “Acqg. Params” menu
(acquisition parameters) and tick 80, 206, 248/232, 207, 208, 204, 238, 220, and
click ok. These isotopes will now appear on the tune screen

Start laser firing, open shutter, click start on tune screen

238 d 208

When over one million counts in “°U an Pb click stop on the Tune panel. Select
Tune > P/A Factor > click “Load Masses from acq. Method” > Run

When the notepad automatically pops up, check that **U and **®Pb are in detection
range (they will have a number next to them, usually about 0.9) then click “Yes” to

new P/A Factor, click “Save”
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Stop laser firing, close shutter
Turn settings back to normal (5 Hz for laser fire rate, 30 um for spot size and 85%
laser intensity)

Running the method

The analytical method for Laser Ablation starts with the user running a number of
standards. The first of these standards will be recognised by the Glitter software
and when loaded into a Glitter processing session will be assigned a star (*) and
data associated with them. The standards allow the calibration of laser ablation
data in two ways: measure ablation yield and drift in signal over the period of the
analyses and degree of fractionation. Some standards are run as unknowns. By
analysing material of known composition or age, we can evaluate whether or not
our selected standards analyses are valid.

Using the Chemstation computer:

Create a folder on the D: drive to store your data and relevant sub-folders for
individual samples/ runs

Move the laser ablation cell to the first standard

Select “Method” > “Run.” Enter the path where the files are going to be stored (can
be copied and pasted from Microsoft Explorer e.g. D:\username\samplename\) and
add the name of the spot analysis to the end of this path (Chemstation creates
folder of data with this name). For example the first spot analysis for zircon would
be a GJ standard, and so the path filename would look like
D:\username\samplename\GJ_01

Thus, for every spot after that for this specific sample you would only need to
modify the spot name and leave the path directory as it is

Click “Run Method” and view the time elapsed value displayed on the screen. The
first part of the run will be background. The laser is then fired and the shutter
opened (background collection for 40 seconds, fire laser for 10 seconds and open
shutter at 50 seconds total. At end of full 120 seconds, stop laser and close shutter.
Method must be run to full completion for the data to be saved. When completed it
will exit back to the Tune screen

Data is now ready to be viewed in Glitter program

Using Glitter

Open the Glitter program from the desktop of the Glitter computer
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Choose “isotope ratios” when conducting geochronology or “element
concentration” when attempting trace element analysis

To load data files into Glitter, select “File” > “Load data” and navigate to the I: drive.
This takes the data from the central computer across the network. Then navigate to
the root directory where all your spot analyses are stored. Click ok

A window will pop up in which the user must set the detector dwell times, which
have been setup in the method on Chemstation. For zircon geochronology, the

following dwell times are used:

Isotope Dwell time in msec

204 10

206 15

207 30

208 10

232 10

238 15

For trace element analysis in zircon, the following dwell times are used: Si, Zr, Th, U
10 msec; all other elements 20 msec

Click “Accept” twice, then ok to the box that pops up

Then choose “Display” > “Age Estimates” to display spot ages; or “concentration”
for trace elements in ppm

Select “Review Signal Selection” from the “window” pull down menu. This window
is where signal selection points can be altered to choose where signal and
background counts are considered to be

Check that the ages/concentrations of the standards match those from the standard
block selection

Now for every spot conducted the user simply needs to hit the “Update” button in
Glitter, which will automatically bring the next spot analysis across from the central

computer.

9.10. After a series of standards have been analysed, the Glitter program will

prompt the user for a different routine for processing the standard/calibration data.
To begin, choose “Linear fit to ratios” in the Windows Options drop down menu.

Also select “Tie standard markers to analysis” in the second drop down list
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10. Completing a run
10.1. Spot analysis was done under the following pattern to prevent the Glitter
program from becoming overloaded and slowing down:

For geochronology (one run):

10.1.1. Std GJ x3
10.1.2. Ples or BJWP x2
10.1.3. Std GJ x2
10.1.4. Samples x20
10.1.5. Std GJ x3
10.1.6. Ples or BJWP x2
10.1.7. Std GJ x2

For trace elements (one run):

10.1.8. Std NIST 612 x3
10.1.9. GJx1

10.1.10. Std NIST 612 x2
10.1.11. Samples x20

10.1.12. Std NIST 612 x2
10.1.13. GJx1

10.1.14. Std NIST 612 x2

10.2. Data was then exported, Glitter program restarted, and the last set of

standards copied into a new folder for use with the next run

11. Exporting data from Glitter

11.1. Once the required amount of data has been obtained (i.e. one run), select
“File” > “Export” in the Glitter program

11.2. Leave the default boxes selected, additionally select “Mean Count Rates
(cps), background subtracted” then click ok

11.3. Save the data to the default location (this will automatically be the same
folder the program has loaded the original data from) and click “Save”

12. Shutting down the laser

12.1. In the ICP-MS Top program, select “Instrument” > “Instrument Control”

12.2. Turn off the plasma under the “Plasma” drop down menu or by hitting the

“Plasma Off” icon
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12.3. Shut down the Laser Ablation software on the NewWave computer. This
turns off the light source in the laser unit and preserves the bulb

12.4. Turn off the monitors on all three computers. Do not shut down the
computers

13. Removing samples

13.1. Loosen the screws on the laser ablation chamber door and slide the door to
the left

13.2. Slide the sample holder out

13.3. Carefully remove samples and standards

13.4. Return sample holder to the chamber

SOLUTION ICP-MS

Method specific sample preparation:
1. Clean 15 mL PFA vials

1.1. Wipe outside of vials with ethanol and tissue to clean off previous sample labels

1.2. Pour a small amount (approx. 5 mm depth) recycled 6M HCl into each vial

1.3. Put lids on vials

1.4. Place vials on a hot plate set at 140°C (in fume cupboard)

1.5. Leave for 30+ minutes

1.6. Switch off hot plate and remove the vials, placing them on a temperature suitable
material to cool

1.7. Fill a 4L beaker with 2-2.5L of deionised water

1.8. Bring the vials and beaker to the same fume cupboard

1.9. Pour remaining HCl from the vials into a ‘waste’ jug

1.10. Place now emptied vials and their lids into the beaker of water

1.11. Dispose of waste HCl appropriately (in this case, into a larger container for
waste HCI)

1.12. Drain water from beaker

1.13. Add vials to cleaning container for longer term cleaning

1.13.1. Take rack out of cleaning container
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1.13.2. Place lids upside down on the top row of rods, place vials upside-down on

the bottom row of rods

1.13.3. Return rack to container, secure the top half (lid)

1.13.4. Remove the stopper from the funnel at the top

1.13.5. Ensure drainage spout is closed

1.13.6. Pour 1L of 69% nitric acid into a measuring jug and then into the container

via the funnel. Rinse measuring jug with deionised water

1.13.7. Reinstate stopper, but leave the stopper loose to prevent pressure build up
within the container

1.13.8. Switch on hotplate beneath the container — set to 170°C

1.13.9. Leave overnight, then switch off hot plate and allow the container to cool
for approx. 30 minutes

1.13.10. Drain nitric acid into measuring jug by opening the spout and return to
original Winchester (can be reused up to 20 times for this purpose). Update the
number of uses marked on the Winchester. Rinse measuring jug with deionised
water and ensure spout is reclosed

1.13.11. Pour 1L deionised water from a measuring jug into the container via funnel

1.13.12. Leave with hotplate at 170°C for approx. 8 hours (i.e. during day), then
switch off hot plate and allow to cool for approx. 30 minutes

1.13.13. Drain water into measuring jug by opening spout and dispose of
appropriately (pour down drain) and close spout

1.13.14. Measure out 1L 37% HCl into a measuring jug and pour into container via
funnel and return stopper

1.13.15. Leave with hot plate at 170° for approx. 2 days

1.13.16. Drain HCl into measuring jug and return to original Winchester. Update the
number of uses marked on the Winchester. Close spout and refill container with 1L
deionised water. Leave for approx. 2 days

1.13.17. Drain water and dispose. Remove rack with vials and lids and place on open

bench space

1.14. Flick excess water off vials and caps and lay out on clean bench
1.15. Fill each vial with approx. 0.5 cm depth 6M HCl and put lids on
1.16. Place vials on hot plate at 140°C and leave for approx. 24 hours
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Remove vials from hotplate and allow to partially cool. Tip out HCl into a
beaker (ok to reuse) and rinse vials/ lids with deionised water. Check for areas
where water clings to the sides of the vials — mark these vials with an ‘x’ and only
use if you have to

Cap rinsed vials and place in clean, labelled tub ready for weighing
Weighing

Use Mettler Toledo AT201 balance in air lock room B13

2.1.1.Long and short term stability of the scale is monitored for all weighing sessions by

2.2.
2.3.

2.4.
2.5.

2.6.
2.7.
2.8.

first weighing a standard 100g weight from the weights box and recording this in
the log book

Label a 15 mL vial with black marker pen and record label in log book

Uncap the vial and hold with the balance tweezers. Use the Zerostat gun to remove
static charges by holding it approx. 10 cm from the vial and slowly squeezing and
releasing the trigger over about 4 seconds. If a ‘crack’ sound is heard, repeat more
slowly.

Place vial on balance and tare

Use a spatula to add approx. 0.05g of powdered sample to the vial. Record in log
book to 4 decimal places

Remove vial from balance, add approx. 2 mL 7M HNO; and cap vial

Record all weights, etc. in the log book

Repeat for all samples

2.8.1.Include at least one rock standard and one blank (blank does not have sample to be

2.9.
3.
3.1.
3.2.
3.3.

3.4.
3.5.

weighed, but needs to have the 2 mL 7M HNO; added)

Repeat weighing of the standard 100g weight and record in log book

Dissolution of sample powders

Add 4 mL of HF from the dispenser into each vial

Heat capped vials overnight on a hotplate set to 140°C

Remove vials from hotplate and allow to cool slightly to make them more
comfortable to handle

Gently tap the vials at a slight angle to collect any acid drops from the top or sides
Remove caps and return vials (and caps upside-down) to the hotplate to evaporate
to dryness at 140°C for approx. 2 hours (add approx. 2 mL of 7M HNO; when nearly

dry to prevent insoluble fluorides forming).
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3.6. Allow to cool, then add 4 mL HF + 2 mL 7M HNO;

3.7. Recap and heat overnight at 140°C on a hot plate

3.8. Again, remove vials from hotplate and allow to cool slightly to make them more
comfortable to handle

3.9. Gently tap the vials at a slight angle to collect any acid drops from the top or sides

3.10. Remove caps and return vials (and caps upside-down) to the hotplate to
evaporate to dryness at 140°C for approx. 2 hours (add approx. 2 mL of 7M HNO;
when nearly dry to prevent insoluble fluorides forming).

3.11. Allow to cool, then add 6 mL HCl to the solid residue

3.12. Heat capped vials on hotplate at 140°C until completely dissolved
(overnight)

3.13. Allow to cool to room temperature and assess solutions for remaining solids
(may need to repeat evaporation processes)

4. Centrifuge

4.1. Evaporate to dryness on a 140°C hotplate

4.2. Cool, then use the balance to add 5mL of 5% HNO; + 0.1% HF mix to each vial while
on the balance, record the weight of acid added and leave to dissolve. This
produces a 100x dilution factor (dilution factor 1)

4.3. Rinse 2 mL centrifuge vials (stored in 6M HCI) three times inside and out with DI
water and store in rack

4.4. Place rack on hotplate set to 120°C to speed up drying

4.5. Pipette 1.5 mL of each solution into labelled centrifuge vials

4.6. Using the Micro Centrifuge in room B14, centrifuge the samples for 5 minutes at
13200 rpm

5. Dilution

5.1. Using the balance to obtain more accurate weight measurements at each stage;
pipette 0.5 mL of the centrifuged sample solution into a 5mL ICP-MS vial

5.2. Add 4.5 mL 5% HNOs + 0.1% HF mix. This produces a 10x dilution factor (dilution
factor 2)

5.3. Total dilution factor is the product of the first and second dilution factors (i.e. 100 x
10 = 1000x dilution)

6. Reference and calibration solutions
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6.1. 25 mL of 200 ppb indium and rhenium reference solution is required per 100
samples
6.1.1.0.5 mL (1 ugg-1 In) + 0.005 mL (1000 ugg-1 Re) + 24.5 mL (5% HNO3 + 0.1% HF mix)
6.2. 5mLof 0, 10, 20, 50, 200 and 500 ppb calibration solution are also required
6.2.1.Prepare 10 mL 500 ppb by weighing 0.5 mL of the two calibration solutions (‘A’ and
‘B’)! into 20 mL vial then adding 9.5 mL 5% HNO; + 0.1% HF mix. Record all weights

6.2.2.The other solutions can be made up from the 500 ppb solution

6.2.2.1. 0 ppb =5mL 5% HNO; + 0.1% HF mix

6.2.2.2. 10 ppb = 0.1 mL 500 ppb solution + 4.9 mL 5% HNO; + 0.1% HF mix
6.2.2.3. 20 ppb =0.2 mL 500 ppb solution + 4.8 mL 5% HNO; + 0.1% HF mix
6.2.2.4. 50 ppb = 0.5 mL 500 ppb solution + 4.5 mL 5% HNO; + 0.1% HF mix
6.2.2.5. 100 ppb =1 mL 500 ppb solution + 4 mL 5% HNO; + 0.1% HF mix
6.2.2.6. 200 ppb =2 mL 500 ppb solution + 3 mL 5% HNO; + 0.1% HF mix
6.2.2.7. 500 ppb =5 mL 500 ppb solution

6.2.2.8. Record all weights

ELECTRON MICROPROBE (15KV, 20NA)

Thin sections from Stewart (1994) were analysed on the microprobe. Some had
been previously run and still had their original carbon coating in good condition,
others either had not been run previously or had had their carbon coating removed
since then. In total, nine thin sections were analysed. Circles were drawn onto the
back of the thin sections to mark areas of interest so that they could be easily
found.
1. Load samples
1.1. Remove previous samples
1.1.1.“SX FIVE Control” window — “vacuum” tab — “sample exchange” button — “transfer

the sample out of the chamber” option — follow instructions in pop up box

! Solution A: HPS-Q17617A is 10mg/L of Al, As, Ba, Be, Bi, Ca, Cd, Ce, Cs, Co, Cr, Cu, Dy, Er, Eu, Fe, Ga, Gd,
Ho, La, Pb, Li, Lu, Mg, Mn, Na, Nd, Ni, P, K, Pr, Rb, Sc, Se, Sm, Sr, Tb, Th, Tl, Tm, U, V, Y, Yb, Zn in 2% HNO;
Solution B: Cat#ICP-MS-68A Solution B is 10mg/L of Sb, Ge, Hf, Mo, Nb, Si, Ag, Ta, Te, Sn, Ti, W, Zr in 2%
HNO; + Tr HF
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1.1.2.0pen transfer valve using the lever to the left of the sample-loading door by
pushing in and sliding up. The lever will flick to the left at the top

1.1.3.flick the latch to the left so that the arrow on the top points out

1.1.4.release handle and slide slowly forward (spring loaded so needs to be held the
whole time), slide back — watch through window to ensure sample plate comes back
with it

1.1.5.close the valve by twisting the lever on the left to the right, then sliding it down

1.1.6.click “ok” on pop up window

1.1.7.wait for air lock to vent

1.1.8.push screw on left side of access door in and pull door back to open (swings right)

1.1.9.push sample plate to release, slide out and place on bench

1.1.10. close door

1.2. Put carbon coated thin sections on sample plate

1.2.1.Put latex gloves on

1.2.2.Have sample plate with hole in one end facing you

1.2.3.Slide previous thin sections out by pushing down gently and sliding up/ down

1.2.4.Slide new thin sections in with carbon coating facing up

1.2.5.Record sample numbers and order of thin sections on the plate (with first furthest
away)

1.2.6.Stick carbon tape where two thin sections meet, ensuring that some tape also
covers the edge of the sample plate to ensure thin sections do not move. Remove
white backing of tape with tweezers

1.2.7.0verlay plastic grid on samples and record rough coordinates of where the marked
circles are (x, y)

1.2.8.Remove grid before loading samples

1.3. Load new samples

1.3.1.0pen access door and slide sample tray into place, hole end first, push until it clicks
on (but don’t push so far that it releases)

1.3.2.Close door

1.3.3.“SX FIVE Control” window — “vacuum” tab — “sample exchange” button — “transfer
the sample into the chamber” option — if door is properly closed, click “ok” to pump
airlock” — follow instructions in pop up box

1.3.4.0pen transfer valve with lever as above
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1.3.5.Flick latch back up so that the arrow is pointing inwards

1.3.6.Slide handle forward and then back, watching through window to make sure sample

plate does not come back out

1.3.7.Close transfer valve as above

1.3.8.Click “ok”

2.

2.1.

2.2.
2.3.

3.1.
3.2.

Turning electron beam on

“Beam and SEM setup” window — click “File” — select “load” from drop down menu
— choose appropriate settings (in this case the first settings in the list were selected
“hv15nA20”

Wait for beam to load

Go to “SX FIVE Control” window, select “Beam” tab. The diagram will show a red
beam when the beam is finished loading. Can also check kV settings here
Navigating to circles

Go to “SX FIVE Control — Roller” window

Enter x- and y-coordinates obtained from the grid laid over the samples before

loading into boxes labelled “X” and “Y”

3.2.1.Type the number, then press “Enter” on keyboard and wait for the stage to move

3.3.

3.4.
3.5.

3.6.

4.1.

4.2.
4.3.
4.4.

before adding the next coordinate

In the same window, beam and light options are shown in the top right. Check
Beam “Cut” and Scanning “Off”, then Light “On”

Press the button on the top right of the joystick control to auto focus

Return to same window and select Light “Off,” Beam “On” and Scanning “On.” A
back-scatter image will now be visible in the top right screen

Use the joystick to navigate the back-scatter image to find the circle and desired
area of analysis

Quick analysis to help identify minerals of interest

To obtain a quick look at what elements are present in a particular area, turn
Scatter “Off” and go to the “Esprit” window and click “Acquire” button

Wait while data is acquired

A graph will be shown with peaks where a response has been recorded

Elements can be assigned to these peaks by clicking approximately in the centre of
each peak and selecting the most likely element from the selection in the box in the

top right corner of the graph
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To return to navigating around the sample via back-scatter image, switch Scanning
“On” and Beam “On” (Beam will automatically switch to “Cut” when finished
acquiring

Saving a back-scatter image (Light “Off”, Beam “On”, Scanning “On”)

Set the position of the image using the joystick navigation

Adjust focus and magnification as necessary using the knobs labelled “MAG.” And
“FOCUs”

Go to the “Acquire” window (left screen) — “Imaging” button — new window will
open up — “Start Image” button

Wait for image to develop in the new window

Click “Save As” button — name the file identifying the image by sample number and
circle number (e.g. EU1 circlel) — “Save”

Close the new window (click “No” when pop-up asks to save to probe database)
Choosing points for analysis and recording them

Navigate to desired area using joystick (Beam “On”, Scanning “On”, Light “Off)

Go to the “Automate” window — “Digitize” button — new window will pop up
“Digitize Samples” — name the position in the “Unknown position name” box (name
the same as the image i.e. sample number circle number) — “Add new unknown to
position list” button

New position will appear in the “Position List” in “Automate” window

Choosing single points for analysis

Navigate to specific mineral/ point — in “Digitize Samples” window, select “Single
Point(s)” button to record the location of the desired point of analysis (x- and y-
coordinates will now appear in the “Automate” window

Repeat step (a) until desired number of points for the circle have been recorded
Choosing a grid of points for analysis

Instead of clicking “Single Point(s)” button, select “Rectangular Grid” button — new
window will open

Set top left corner coordinates by navigating to a particular area and selecting the
“Update Start” button in the new window

Set the bottom right corner coordinates by navigating to a point down and right of
the starting point and click “Update Stop” button

Set grid step sizes in microns using the “X-step” and “Y-step” boxes
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8.5. Click “ok” button

8.6. List of points will appear in the “Automate” window under the same unknown
position name

9. Choosing points along a linear traverse

9.1. Instead of “Single Point(s)” button, select “Linear Traverse” button

9.2. As with selecting a grid of points, a new window will pop up and ‘Start’ and ‘Stop’
positions will need to be selected by navigating to them and clicking the appropriate
“Update Start” or “Update Stop” button

9.3. Input the desired number of steps in the traverse into the “Traverse Steps” box

9.4. Click “OK”

9.5. Alist of points will appear in the “Automate” window under the same unknown
position name

10. To begin adding points to the next circle, navigate to it using the joystick and/or

enter new x- and y-coordinates as appropriate. Repeat steps 3-6, followed by steps
7, 8, and/or 9 as desired.

11. To record points onto the back-scatter image

11.1. Have the current circle selected in the “Position List”

11.2. In “Digitize” window, select “Picture Snap” button. A new window will pop
up

11.3. Open “File” drop down menu — “Load BMP Image” — select image file that

corresponds to the open circle number — “Open”

11.4. In “Display” drop down menu, select “Digitized unknown position samples”
and “Digitised position sample long labels” (a tick will appear to the left of each
option to indicate they are activated)

11.5. Red circles and corresponding number labels will appear at approximately
the same location on the open back-scatter image as they were on the actual back-
scatter image (NB: coordinates may be slightly off in the saved image, but those
selected based on the real-time back-scatter image will be in the correct position)

11.6. To save the back-scatter image with the points, open “File” drop down
menu — select “Save as BMP (with graphics data)” — name file with the same sample
number and circle number information, add ‘spots’ to the end to identify the image
as one with the points information on it

12. To run full analysis of selected points
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12.1. “Automate” window — select samples to analyse from the “Position List” by
clicking and dragging up/down to the end of the currently loaded sample set —
“Sample Setups” button, new window pops up — click “OK” — click “Yes” — returns to
“Automate” window — select “Run Selected Samples” button — pop up gives

estimated time to completion and asks for confirmation — click “OK”

XRF — FUSED DISCS

Method specific sample preparation:

1. Wash the glassware (vials, stopper lids) and crucibles. Enough crucibles for the
number of samples, enough glass vials for the number of samples x3, enough lids
for the number of samples x2

1.1. Using warm soapy water, a bottle brush and a cloth, wipe/gently scrub off any
previous labelling and residues

1.2. Lay out each piece upturned on paper towel

1.3. Rinse each item in tap water, followed by deionised water. Rinsing with deionised
water should be done three times

1.4. Place upturned on paper towel

1.5. Wipe out glass dishes

1.6. Place each vial upright in the glass dishes, with enough vials in each dish for the
number of samples to analyse. Do the same with the crucibles

2. Dry glassware and crucibles for a minimum of 30-40 minutes at 110°C

2.1. Place the dishes of vials and crucibles on the shelves in the oven
2.2. Lay out the lids on some paper towel on top of the oven. The heat from the oven
will dry them. Do not place in oven as the plastic will go soft

3. Drysamples for at least 30-40 minutes at 110°C

3.1. Takes vials with lip (no lid) out oven

3.2. Label vials with samples numbers

3.3. Scoop one slightly heaped spoonful of powdered sample into corresponding vial.
Wipe spoon clean with tissue after each sample

3.4. Put vials with samples back into the dish and place on a shelf in the second oven

4. Weigh out samples into crucibles
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Record sample number, crucible number, crucible weight to four decimal places
Tip each sample into one crucible, then weigh again and record the crucible +
sample weight

Set filled crucibles out in silica trays ready to go into the furnace

Heat samples in furnace

Place silica trays with sample-filled crucibles into the furnace

Lock the door

Select appropriate program (2) — heat furnace at rate of 400°C per hour until 900°C,
remains at 900°C for three hours, cools

Leave program to run overnight

Remove samples from furnace and re-weigh

Allow samples to cool to room temperature in a decanter

Weigh crucible with sample in it. Record weight

Tip sample into a new (clean) glass vial and place stopper lid on. Label each vial as
you go

Can now calculate L.O.1 %

Dry x-ray flux in oven at 110°C for at least two hours

Allow x-ray flux to cool to room temperature in a decanter

Measure out x-ray flux and sample into glass vials

Approx. 1g sample and 4g flux

Label new (clean) glass vial and lid

Place vial on scale. Tare scale

Add approx. 1g sample with a spatula. Record weight

Tare scale again

Add approx. 4g flux using different spatula. Record weight

Put on lid and mix sample and flux by gently tipping/ rolling the vial

Wipe spatulas clean with a tissue between each sample and keep flux in decanter

when not using

10. Fused disc preparation

10.1. Contents of vial are now ready to be transferred to a Pt/5% Au crucible for

10.2.

fusion by heating above an oxy-propane flame (temp = 1100°C)
Using Norrish-Chapman Prometheus Fusion Apparatus, crucible is heated

for 10 minutes, until fusion is complete. The melt is the poured into a Pt/Au mould
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and force cooled to room temperature using air ‘jets’ while the mould is still on the

supporting ring

10.3. Sample disc is then labelled and ready for Whole Rock Analysis by XRF

11. Fused discs were taken to the CSIRO to run the Whole Rock Analysis

XRF — pressed pellets

Method specific sample preparation:

1. Weigh out sample powder and licowax binder into labelled glass vials
1.1. 6g sample + 1.5g binder
2. Cap vials and shake to mix powder and binder well
3. Use ethanol and tissue to clean components of pellet making equipment (see Figure
1)
4. Clean base first so that wall piece can be assembled onto it to avoid contamination
after cleaning. Place stick top down on bench
5. Place an Al cup into the top of the wall piece. May need to use a cleaned spatula to
push the cup down to the base
6. Carefully pour in mixed sample + binder into the Al cup
7. Slowly push stick in to avoid air pushing powder out
8. Place assembled pieces into the press (lift from base)
9. Lock valve by using the pole to turn the screw clockwise
10. Pump jack by hand until it becomes difficult
11. Place pole end in jack hole and pump until pressure on barometer at bottom left of
press reads approx. 3
12. Leave for a few seconds before releasing the valve by using the pole to turn the
screw anticlockwise
13. Press stage will slowly lower by itself, but can be sped up by pushing it down with
your hands
14. Remove the pieces (lifting from the base) from the press and place on the bench
15. Lift the wall from the base — stick and Al cup will be lodged in the wall piece
15.1. To remove stick and Al cup, use the press as follows:
15.1.1. Place cloth on the press stage to unsure a soft landing for the Al cup
(prevents damage to the pellet)
15.1.2. Place hollow metal tube on the tissue, with window hole facing you
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15.1.3. Place wall and stick assembly onto the tube, with the Al cup at the bottom
(it will fall out onto the cloth)

15.1.4. Lock the valve with the pole, and operate the press by hand until the stick is
pushed into the wall far enough that the Al cup is released and falls down onto the
cloth (will be able to see it through the window hole once is falls)

15.1.5. Release the valve and carefully remove the pieces

15.2. Label the base of the Al cup with a permanent marker

16. Clean the pieces with ethanol and tissue

16.1. To remove stick from wall cup, repeat Al cup removing procedure but with
the stick and wall assembly up the other way, so the stick is pushed back through
the wall

16.2. Place a piece of cloth between the stick and the top of the press to prevent
damage to the internal parts of the equipment

16.3. Use ethanol to lubricate the stick and make its removal easier

16.4. May need to repeat the process in opposite directions multiple times until
the stick is able to be pulled free

17. Repeat the process for each sample
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